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1. Before using the machine

Thank you for choosing the Xerox 4110/4590 Copier/Printer. This 

guide describes procedures for PostScript® Driver Library 
software, and the preparation to use them for printing. Before 
using the product, read this guide carefully and make sure that 
you are using it correctly.

The descriptions in this guide assume that users are familiar with 

their computer environments (either the Microsoft® Windows® 
operating system or the Macintosh™) and with the procedures for 
using the Xerox 4110/4590 Copier/Printer.

Refer to this guide as necessary to maximize the usefulness and 
performance of this product.

Terminology

In this guide you will find that some terms are used 
interchangeably:

• Paper is synonymous with media.

• Document is synonymous with original.

• Xerox 4110/4590 Copier/Printer is synonymous with the 
machine.

Orientation

Orientation is used to mean the direction of images on the page. 
When the image is upright, the paper (or other media) can be 
either long edge feed or short edge feed.

Long Edge Feed (LEF) 

When loading documents long edge feed into the document 
feeder, load with one of the long edges facing into the document 
feeder. The short edges appear at the top and bottom of the 
paper, facing the front and back of the document feeder. When 
loading paper long edge feed into a paper tray, place the paper 
with one of the long edges on the left-hand side and one of the 
short edges toward the front of the tray.
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1.  Before using the machine
Short Edge Feed (SEF) 

When loading documents short edge feed into the document 
feeder, load with one of the short edges facing into the document 
feeder. The long edges appear on the top and bottom of the paper, 
facing the front and back of the document feeder. When loading 
paper short edge feed into a paper tray, place the paper with one 
of the short edges on the left-hand side and one of the long edges 
toward the front of the tray.

LEF Orientation SEF Orientation

Paper feed direction Paper feed direction
Xerox 4110/4590 PostScr ipt  User Guide1-2



1. Before using the machine
Safety notices

This Xerox product and the recommended supplies are designed 
and tested to meet strict safety requirements. These include 
safety agency approval and compliance to established 
environmental standards. Please read the following instructions 
carefully before operating the product, and refer to them as 
needed to ensure the continued safe operation of your product.

KEY POINT: The safety testing and performance of this product 
have been verified using Xerox materials only.

WARNING: Any unauthorized alteration, which may include the 
addition of new functions or connection of external devices, may 
impact the product certification. Please contact your authorized 
local dealer for more information.

Electrical safety

• Use only the power cord supplied with this equipment.

• Plug the power cord directly into a correctly grounded 
electrical outlet. Do not use an extension cord. If you do not 
know whether or not an outlet is grounded, consult a qualified 
electrician.

• Do not use a ground adapter plug to connect this equipment to 
an electrical outlet that lacks a ground connection terminal.

WARNING: You may incur a severe electrical shock if the outlet is 
not grounded correctly.

• Do not place the press where people may step or trip on the 
power cord. Do not place objects on the power cord.

• Do not override or disable electrical or mechanical interlocks.

• Do not obstruct the ventilation openings. These openings 
prevent overheating of the machine.
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1.  Before using the machine
WARNING:  Never push objects of any kind into slots or openings 
on this equipment. Making a contact with a voltage point or 
shorting out a part may result in fire or electrical shock.

If any of the following conditions occur, immediately switch off the 
power to the machine and disconnect the power cord from the 
electrical outlet. Call an authorized Xerox service representative 
to correct the problem.

• The machine emits unusual noises or odors.

• The power cord is damaged or frayed.

• A wall panel circuit breaker, fuse, or other safety device is 
tripped.

• Liquid is spilled into the press.

• The machine is exposed to water.

• Any part of the machine is damaged.

Disconnect device

The power cable is the disconnect device for this equipment and is 
attached to the back of the machine as a plug-in device. To 
remove all electrical power from the machine, disconnect the 
power cable from the electrical outlet.

WARNING: This product must be connected to a protective earth 
current.
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1. Before using the machine
Laser safety

North America

This product complies with safety standards and is certified as a 
Class 1 Laser product under the Center for Devices and 
Radiological Health (CDRH) of the United States Food and Drug 
Administration (FDA) implemented regulations for laser 
products. This product complies with FDA 21 CFR 1940.10 and 
1040.11 except for deviations pursuant to Laser Notice No. 50, 
dated July 26, 2001. These regulations apply to laser products 
marketed in the United States. The label on the machine indicates 
compliance with CDRH regulations and must be attached to laser 
products marketed in the United States. This product does not 
emit hazardous laser radiation.

CAUTION: Use of controls or adjustments or performance of 
procedures other than those specified herein may result in 
hazardous exposure of laser light.

Since radiation emitted inside this product is completely confined 
within the protective housing and external covers, the laser beam 
cannot escape from the machine during any phase of the user 
operation.

This product contains laser warning labels. These labels are 
intended for use by the Xerox Service Representative and are 
placed on or near panels or shields that require special tools for 
removal. Do not remove any of the panels. There are no operator 
serviceable areas in these covers.
Xerox 4110/4590 PostScr ipt User Guide 1-5



1.  Before using the machine
Europe (EU) and other markets

This product complies with IEC’s safety standard 60825-1 (Edition 
1.2) issued August 2001.

The equipment complies with laser product performance 
standards set by governmental, national, and international 
agencies as a Class 1 Laser Product. It does not emit hazardous 
radiation as the beam is totally enclosed during all phases of 
customer operation and maintenance.

CAUTION: Use of controls or adjustments or performance of 
procedures other than those specified herein may result in 
hazardous radiation exposure.

This product contains laser warning labels. These labels are 
intended for use by the Xerox Service Representative and are 
placed on or near panels or shields that require special tools for 
removal. Do not remove any of the panels. There are no operator 
serviceable areas inside these covers.

If you need additional safety information concerning the product or 
Xerox supplied materials, you may call the following number:

+44 (0) 1707 353434

Safety standards

North America

This Xerox product is safety certified by Underwriters Laboratories 
Incorporated to Standards UL60950-1 (first edition), and CSA 
International CAN/CSA C22.2 No. 60950-1-03 (First Edition).

Europe (EU) and other markets

This Xerox product is safety certified by Underwriters Laboratories 
Incorporated to publication IEC60950-1 (2001) First Edition.
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1. Before using the machine
Maintenance safety

• Do not attempt any maintenance procedure that is not 
specifically described in the documentation supplied with your 
product.

• Do not use aerosol cleaners. The use of supplies that are not 
approved may cause poor performance of the press and could 
create a dangerous condition.

• Use the supplies and cleaning materials only as directed in 
this manual. Keep all materials out of the reach of children.

• Do not remove the covers or guards that are fastened with 
screws. There are no parts behind these covers that you can 
maintain or service.

Do not perform any maintenance procedures unless you have 
been trained to do them by a Xerox representative, or unless a 
procedure is specifically described in one of the manuals included 
with your press.

Operational safety

Your Xerox equipment and supplies were designed and tested to 
meet strict safety requirements. These include safety agency 
examination, approval, and compliance with established 
environmental standards.

Your attention to the following safety guidelines will help ensure 
the continued safe operation of your product:

• Use the materials and supplies specifically designed for your 
product. The use of unsuitable materials may result in poor 
performance of the machine and possibly a hazardous 
situation.

• Follow all warnings and instructions that are marked on or 
supplied with the machine.

• Place the machine in a room that provides adequate space for 
ventilation and servicing.

• Place the machine on a level, solid surface (not on a thick pile 
carpet) that has adequate strength to support the weight of the 
machine.

• Do not attempt to move the machine. A leveling device that 
was lowered when your machine was installed may damage 
the carpet or floor.

• Do not set up the machine near a heat source.

• Do not set up the machine in direct sunlight.
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1.  Before using the machine
• Do not set up the machine in line with the cold air flow from an 
air conditioning system.

• Do not place containers of coffee or other liquid on the 
machine.

• Do not block or cover the slots and openings on the machine.

• Do not attempt to override any electrical or mechanical 
interlock devices.

WARNING: Be careful when working in areas identified with this 
warning symbol. These areas may be very hot and should not be 
touched.

If you need any additional safety information concerning the 
machine or materials, contact your Xerox representative.

Ozone safety

This product produces ozone during normal operation. The ozone 
is heavier than air, and the quantity is dependent on print volume. 
Providing the correct environmental parameters, as specified in 
the Xerox installation procedures, ensures that concentration 
levels meet safe limits.

If you need additional information about ozone, request the Xerox 
publication, OZONE by calling 1-800-828-6571 in the USA. For a 
French language version, call 1-800-828-6571 in the USA, then 
press 2.
Xerox 4110/4590 PostScr ipt  User Guide1-8
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Notices

Radio frequency emissions

FCC in the USA

This equipment has been tested and found to comply with the 
limits for a Class A digital device, pursuant to Part 15 of the 
Federal Communications Commission (FCC) Rules. These limits 
are designed to provide reasonable protection against harmful 
interference when the equipment is operated in a commercial 
environment. This equipment generates, uses, and can radiate 
radio frequency energy and, if not installed and used in 
accordance with the instruction manual, may cause harmful 
interference to radio communications. Operation of this equipment 
in a residential area is likely to cause harmful interference in which 
case the user will be required to correct the interference at his/her 
own expense.

Changes or modifications to this equipment not specifically 
approved by the Xerox Corporation may void the user’s authority 
to operate this equipment.

WARNING: Shielded cables must be used with this equipment to 
maintain compliance with FCC regulations.

In Canada (ICES-003)

This Class “A” digital apparatus complies with Canadian ICES-
003.

Cet appareil numérique de la classe “A” est conforme á la norme 
NMB-003 du Canada.
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Regulatory information for RFID (EU)

This product generates 13.56 MHz using an Inductive Loop 
System as a Radio Frequency Identification system Device 
(RFID). This system is certified in compliance with European 
Council Directive 99/5/EC and applicable local laws or regulations 
as applicable.

Regulatory information for RFID (US)

This product generates 13.56 MHz using an Inductive Loop 
System as a Radio Frequency Identification system Device 
(RFID). This device meets the FCC Part 15C Unlicensed Modular 
Transmitter Approval requirements set forth in Public Notice 
DSA00-1407.

Safety extra low voltage approval

This Xerox product is in compliance with various governmental 
agencies and national safety regulations. All system ports meet 
the Safety Extra Low Voltage (SELV) circuits for connection to 
customer-owned devices and networks. Additions of customer-
owned or third-party accessories that are attached to the press 
must meet or exceed the requirements previously listed. All 
modules that require external connection must be installed per the 
installation procedure.
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Certifications in Europe

The CE marking that is applied to this product symbolizes Xerox 
Declaration of Conformity with the following applicable Directives 
of the European Union as of the dates indicated:

July 22, 1993: Council Directive 73/23/EEC amended by Council Directive 93/68/
EEC, approximation of the laws of the member states related to 
low voltage equipment.

July 22, 1993: Council Directive 89/336/EEC amended by Council Directive 93/
68/EEC, approximation of the laws of the member states related 
to electromagnetic compatibility.

March 9, 1999 Council Directive 99/5/EC on radio equipment and 
telecommunications terminal equipment and the mutual 
recognition of their conformity.

A full declaration, defining the relevant directives and referenced 
standards, can be obtained from your Xerox Limited 
representative or by contacting:

Environment, Health and Safety
Xerox
Bessemer Road
Welwyn Garden City
Herts
AL7 1BU
England
Tel Number +44 (0) 1707 353434

WARNING: This system is certified manufactured and tested in 
compliance with strict safety and radio frequency interference 
regulations. Any unauthorized alteration which includes the 
addition of new functions or the connection of external devices 
may impact this certification. Please contact your local Xerox 
Limited representative for a list of approved accessories.
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1.  Before using the machine
WARNING: In order to allow this equipment to operate in 
proximity to Industrial, Scientific, and Medical (ISM) equipment, 
the external radiation from the ISM equipment may have limited or 
special mitigation measures taken.

WARNING: This is a Class A product in a domestic 
environment. This product may cause radio frequency 
interference in which case the user may be required to take 
adequate measures.

WARNING: Shielded cables must be used with this equipment to 
maintain compliance with Council Directive 89/336/EEC.

It’s illegal in the USA

Congress, by statute, has forbidden the reproduction of the 
following subjects under certain circumstances. Penalties of fine 
or imprisonment may be imposed on those guilty of making such 
reproductions.

1. Obligations or Securities of the United States Government, 
such as:

Certificates of Indebtedness National Bank Currency

Coupons from Bonds Federal Reserve Bank Notes

Silver Certificates Gold Certificates

United States Bonds Treasury Notes

Federal Reserve Notes Fractional Notes

Certificates of Deposit Paper Money

Bonds and Obligations of certain agencies of the government, 
such as FHA, etc.
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1. Before using the machine
Bonds. (U.S. Savings Bonds may be photographed only for 
publicity purposes in connection with the campaign for the sale 
of such bonds.)

Internal Revenue Stamps. (If it is necessary to reproduce a 
legal document on which there is a canceled revenue stamp, 
this may be done provided the reproduction of the document is 
performed for lawful purposes.)

Postage Stamps, canceled or uncanceled. (For philatelic 
purposes, Postage Stamps may be photographed, provided 
the reproduction is in black and white and is less than 75% or 
more than 150% of the linear dimensions of the original.)

Postal Money Orders.

Bills, Checks, or Drafts of money drawn by or upon authorized 
officers of the United States.

Stamps and other representatives of value, of whatever 
denomination, which have been or may be issued under any 
Act of Congress.

2. Adjusted Compensation Certificates for Veterans of the World 
Wars. 

3. Obligations or Securities of any Foreign Government, Bank, or 
Corporation.

4. Copyrighted material, unless permission of the copyright 
owner has been obtained or the reproduction falls within the 
“fair use” or library reproduction rights provisions of the 
copyright law. Further information of these provisions may be 
obtained from the Copyright Office, Library of Congress, 
Washington, D.C. 20559. Ask for Circular R21.

5. Certificates of Citizenship or Naturalization. (Foreign 
Naturalization Certificates may be photographed.)
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1.  Before using the machine
6. Passports. (Foreign Passports may be photographed.)

7. Immigration Papers.

8. Draft Registration Cards.

9. Selective Service Induction Papers that bear any of the 
following Registrant’s information:

Earnings or Income Dependency Status

Court Record Previous military service

Physical or mental condition

Exception: United States military discharge certificates may be 
photographed.

10.Badges, Identification Cards, Passes, or Insignia carried by 
military personnel, or by members of the various Federal 
Departments, such as FBI, Treasury, etc. (unless photograph 
is ordered by the head of such department or bureau.)

Reproducing the following is also prohibited in certain states: 
Automobile Licenses - Drivers’ Licenses - Automobile 
Certificates of Title.

The above list is not all inclusive, and no liability is assumed for its 
completeness or accuracy. In case of doubt, consult your attorney.
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It’s illegal in Canada

Parliament, by statute, has forbidden the reproduction of the 
following subjects under certain circumstances. Penalties of fines 
or imprisonment may be imposed on those guilty of making such 
copies. 

1. Current bank notes or current paper money.

2. Obligations or securities of a government or bank.

3. Exchequer bill paper or revenue paper.

4. The public seal of Canada or of a province, or the seal of a 
public body or authority in Canada, or of a court of law.

5. Proclamations, orders, regulations or appointments, or notices 
thereof (with intent to falsely cause same to purport to have 
been printed by the Queen’s Printer for Canada, or the 
equivalent printer for a province).

6. Marks, brands, seals, wrappers or designs used by or on 
behalf of the Government of Canada or of a province, the 
government of a state other than Canada or a department, 
board, Commission or agency established by the Government 
of Canada or of a province or of a government of a state other 
than Canada.

7. Impressed or adhesive stamps used for the purpose of 
revenue by the Government of Canada or of a province or by 
the government of a state other than Canada.

8. Documents, registers or records kept by public officials 
charged with the duty of making or issuing certified copies 
thereof, where the reproduction falsely purports to be a 
certified copy thereof.

9. Copyrighted material or trademarks of any manner or kind 
without the consent of the copyright or trademark owner.

The above list is provided for your convenience and assistance, 
but it is not all inclusive, and no liability is assumed for its 
completeness or accuracy. In case of doubt, consult your solicitor.
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Environmental notices for the USA

As an ENERGY STAR® partner, Xerox Corporation has 
determined that this product meets the ENERGY STAR guidelines 
for energy efficiency.

The ENERGY STAR and ENERGY STAR MARK are registered 
United Stated trademarks.

The ENERGY STAR � Office Equipment Program is a team effort 
between U.S., European Union and Japanese governments, and 
the office equipment industry to promote energy-efficient copiers, 
printers, fax, multifunction machines, personal computers, and 
monitors. Reducing product energy consumption helps combat 
smog, acid rain, and long-term changes to the climate by 
decreasing the emissions that result from generating electricity.

Xerox ENERGY STAR equipment is preset at the factory. Your 
machine will be delivered with the timer for switching to Low 
Power Mode from the last copy/print output, set at 15 
minutes. The time to switch to power save (auto off/sleep) mode 
is set at 60 minutes from the last copy/print output. A more 
detailed description of the Power Saver Mode, together with 
instructions on changing the default time to suit your work pattern, 
can be found in the System Administration Guide, System Timers, 
Power Saver section.
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Product recycling and disposal

If you are managing the disposal of your Xerox product, please 
note that the product contains lead, mercury, perchlorate, and 
other materials whose disposal may be regulated due to 
environmental considerations. The presence of lead and 
perchlorate is fully consistent with global regulations applicable at 
the time that the product was placed on the market.

North America

Xerox operates a worldwide equipment take-back and reuse/
recycle program. Contact your Xerox sales representative (1-800-
ASK-XEROX) to determine whether this Xerox product is part of 
the program. For more information about Xerox environmental 
programs, visit www.xerox.com/environment.

For recycling and disposal information, contact your local 
authorities. In the United States, you may also refer to the 
Electronic Industries Alliance web site: www.eiae.org.

Perchlorate Material This product may contain one or more Perchlorate-containing 
devices, such as batteries. Special handling may apply, please 
see www.dtsc.ca.gov/hazardouswaste/perchlorate.

If your product is not part of the Xerox program and you are 
managing its disposal, please follow the instructions provided in 
the above paragraph.

European union

Application of this symbol on your equipment is confirmation that 
you must dispose of this equipment in compliance with agreed 
national procedures.

In accordance with European legislation end-of-life electrical and 
electronic equipment subject to disposal must be managed within 
agreed procedures.

Prior to disposal, contact your local dealer or Xerox representative 
for end-of-life take-back information.

Other countries

Please contact your local waste authorities and request disposal 
guidance.
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Related information sources

This section describes the guides provided with this machine.

• User Guide: This guide describes all the necessary steps for 
copy/print/scan jobs, clearing paper jams, daily care, and 
safety information.

• Administrator Guide: System Administrators use this guide 
to set up the machine defaults/settings and the network 
environment.

• The On-line Help systems (Print Drivers and CentreWare 
Utilities)

• CentreWare Utilities Documentation (HTML)

NOTE: Please note that the screens shown in this user guide 
apply to a fully configured machine and therefore may not exactly 
represent the configuration being used.

Customer documentation updates

You can get the latest customer documentation and information for 
your product by going to www.xerox.com and doing one of the 
following:

• Enter your product number (e.g., 4110, 4595) in the Search 
field and select Search. 

• Select the Support & Drivers link and then use the search 
options to locate your specific printer.

Be sure to periodically check www.xerox.com for the latest 
information for your product.
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2. Windows Me

KEY POINT: The User Interface (UI) screens shown in this guide 
may or may not reflect the screens displayed on your 4110/4590 
system. The UI screens vary from system to system and from 
marketplace to marketplace. Therefore, the UI screens in this 
guide are a representation of the type of screens that may be seen 
on your particular system.

This chapter contains information on:

• The software included for Windows ME

• The hardware and software requirements on page 2-2

• Adobe PS driver installation information and instructions on 
page 2-2

• The device options and print settings for the PS driver on 
page 2-8

About the software

This section describes the software for Windows Me included on 
the PostScript Driver Library CD-ROM.

Bundled software

The following items are included in the “PS\Win_Me”, 
“Utility\ATM\Win_Me, and “Utility\SfontsWin_Me” folders on the 
enclosed CD-ROM. Please read the “Readme.txt” file which 
contains cautionary notes about how to use the printer driver.

Xerox 4110/4590 PS Printer
Driver (ver.4.5.3) and PPD

files

Xerox 4110/4590 PostScript driver and PPD files (for Windows 
Me).

ATM (Adobe Type
Manager)(ver.4.0)

Helps you to install typefaces and activate and manage your fonts.

Adobe Screen Fonts
(TrueType/PostScript)

Includes 136 screen fonts (19 TrueType fonts and 117 PostScript 
fonts), which are compatible with the printer fonts. ATM is used to 
install the PostScript screen fonts. When using these fonts to print, 
it is recommended that you use the Adobe PostScript (4.5.3) 
printer driver.

Adobe Acrobat Reader Allows you to view and print PDF files on all major computing 
platforms.
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2.  Windows Me
Hardware/software requirements

The minimum system requirements for the Windows Me printer 
driver are described below. 

Computer System Personal computer which can run the Windows Me OS

Basic Software Windows Me

The Xerox 4110/4590 PS Printer Driver

KEY POINT: When installing the printer driver, ensure that you 
select the correct one (either 4110 or 4590).

Install Xerox 4110/4590 PS 4.5.3 printer driver onto Windows Me 
by following the procedure below.

It is possible to cancel installation of the printer driver by clicking 
[Cancel] in the dialog box displayed during installation. You can 
also click [Back] to ignore the settings in that dialog box and return 
to the previous dialog box.

Installation procedure

1. Start Windows Me.

2. On the Start menu, point to Settings and click [Printers].

3. In the Printers window, double-click [Add Printer].
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2. Windows Me
4. Click [Next]. 

5. Select how the printer is connected to the computer and click 
[Next].

Select [Local printer] when the printer is connected directly to 
the computer. Otherwise, select [Network printer]. The 
following is an example of a local printer.

NOTE: When you select [Network printer], specify the path to 
the printer in the network path or queue name box.
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2.  Windows Me
6. Insert the PostScript Driver Library CD-ROM in your CD-ROM 
drive.

7. Click [Have Disk]. 

8. Enter “Drive Name:\PrinterDriver\Win_Me” in the “Copy 
manufacturer’s files from:” box and click [OK].

In this example, we have used “D:” as the CD-ROM drive. If 
you are using a different drive for the CD-ROM, specify 
accordingly.

NOTE: Click [Browse] to specify a folder on the CD-ROM.
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9. Select your printer model from the Printers list and click [Next].

10.Type a name for the printer and specify whether you want to 
use the printer as the default printer, then click [Next].
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2.  Windows Me
11.Specify whether or not to print a test page, then click [Finish].

Installation begins.

12.Read the End User License Agreement and click [Agree].

If you click [Disagree],  see page 2-7 for details. 
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2. Windows Me
13.Confirm that a printer has been added in the Printers window. 

• This completes installation of the printer driver. Remove 
the CD-ROM from the drive.

• See “Printer Driver properties” on page 2-8 to configure the 
printer.

• Store your CD-ROM in a safe place.

If you click Disagree in the License Agreement

If you click [Disagree] in the End User License Agreement, the 
following dialog box appears.

• Click [No] to return to the operation and continue.

• Click [Yes] to cancel the installation. A printer is added to the 
Printers window, but the printer driver is not installed properly.

• When you right-click the printer and click [Properties] from the 
menu, the Reinstallation tab is added to the printer driver 
properties dialog box. Follow the directions on that tab.

• When you finish reinstalling the printer driver, continue to the 
“Printer Driver properties" section to set up the printer.
Xerox 4110/4590 PostScr ipt User Guide 2-7
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Printer Driver properties

This section describes printer specific settings included in the 
printer driver properties:

• Configuration Tab

• Options Tab

• Output Settings Tab

NOTE: You can also refer to Help for explanations of these 
settings. See “How to use help” on page 2-18 for details about 
how to use Help.

To view the printer driver properties, select the printer icon in the 
Printers window, then click [Properties] on the File menu.

Configuration tab

This section describes the settings on the Configuration tab.

Select the function that you want to set in the Features List and 
change them in the Settings box below.

NOTE 1: You can restore defaults by clicking [Restore Defaults].

NOTE 2: The settings that can be selected vary depending on 
which options have been installed. Change these settings only 
after confirming that the option settings are complete. See 
“Options tab” on page 2-13.
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Feature List

Offset Stacking The position of individual jobs or sets of copies are shifted to either 
side of the output tray to enable easy separation.

Collated Selects whether to collate a multiple-page file per set when they 
are printed.

Feed Separators from Specifies the paper tray that transparency dividers are to be fed 
from. When [Auto] is selected, the tray set on the machine is used 
as the feed destination.

Print on Separators Specifies whether or not to print on the transparency dividers as 
well as the transparency.

Front Cover Specify whether to add a front cover to the printouts. Select the 
paper tray for feeding the front cover sheets.

Back Cover Specify whether to add a back cover to the printouts. Select the 
paper tray for feeding the back cover sheets.

Tray 8 - Specify Tab Stock Specifies whether or not to print on the transparency dividers as 
well as the transparency.

Stapling Specifies whether or not to staple printed documents and the 

position of the staple. You can staple 2 to 50 sheets of 80 g/m2 or 
lighter paper.

NOTE: You cannot use staples in the following situations:

– When anything other than Finisher Tray is selected for 
Output Destination in the Advanced tab.

– When Job Offset is selected.

Hole Punching Select the punching position.

The holes are made based on the output orientation of the 
paper. As a result, the holes may not be punched correctly 
depending on the position of the image.
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Hole Punching Specify the number of holes to punch. Select from "Use Printer 
Settings," "2 Holes," or "4 Holes."

If "3 Holes" is selected for "Hole Puncher Setup" on the "Device 
Settings" tab, only "Use Printer Settings" will be available for 
selection. "Device Settings" tab is displayed on the print driver 
screen when "Properties" is selected from the menu of the printer 
icon in the "Printers" folder.

Folding Select the folding method.

NOTE: "Z Fold," "Z Tri-Fold," and "C Tri-Fold" will be available 
when the Tri-Fold Output Tray is installed and set up in the 
"Options" tab.

"Bi-Fold" is available when a Booklet Tray is installed and set up in 
the "Device Settings" tab.

Double Print Enable this feature to repeatedly print one page twice on a paper 
with a bigger size than the original. You can use Double Print 
feature if you have set the zoom ratio to 100% with the following 
paper size and output size settings. 

• Paper Size • Output Size

• A4 • A3

• A5 • A4

• B5 • B4

• Folio (8.5 x 11") • Ledger (11 x 17")

Booklet Creation Specify the assembling and finishing methods for booklet creation. 

You can check the result of the change in setting on the preview 
image at the top right of the screen.

KEY POINT: "Booklet Creation" feature will only be available if 
"Automatically Select" or "Auto Paper Select (Type)" is selected in 
"Paper Source" on the "Paper" tab.

Output Size for Booklet
Creation

Specify the output size for booklet creation printing.

When "Booklet Creation" is selected, only "AutoSelect Tray" and 
"Auto Paper Select (Type)" are available in "Paper Source" on the 
"Paper" tab. Conversely, "Booklet Creation" feature is only 
available when "Automatically Select" or "Auto Paper Select 
(Type)" is selected in "Paper Source."
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Booklet Subsets Specify the number of sheets in each subset when printing booklet 
in subsets. Select from "None," or "Every Sheet" to "Every "20 
Sheets."

Skip Blank Pages Specify whether to skip blank pages when printing documents that 
consist of blank pages.

Bypass Feed Orientation Specifies the paper orientation when printing from the bypass tray. 
When feeding the short edge of the paper first, select 
[Landscape]. When feeding the long edge of the paper, select 
[Portrait].

Print Mode Specifies whether to give priority to the print speed or the image 
quality.

Halftone Select the halftone settings for printing.

• Select [Fine Dots] for the small size halftone dot commonly 
used in PostScript.

• Select [Thick Dots] for coarser dots than the Fine Dots setting.

• Select [Type 3] for the same halftone setting that is used in 
PCL.

Image Enhancement Specifies whether or not to use the Image Enhancement function. 
Selecting [On] smooths out boundaries when printing. This 
reduces jagged edges by artificially increasing the resolution of 
the image. When printing a bitmapped image composed of coarse 
halftone dots, smooth color or grayscale gradation is impossible in 
certain situations. In this case, select [Off].

Draft Mode Specifies whether or not to reduce the amount of toner used when 
printing drafts. When [On] is selected, the overall print becomes 
lighter. This is best for printing documents when high print quality 
is not necessary.

Custom Paper Auto
Orientation

Specifies whether or not to correct the orientation of the custom 
paper.
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Substitute Tray Specifies what action to take when the paper for the print size is 
not loaded in the machine.

• Use Printer Settings - Use the printer settings. The settings 
can be confirmed on the control panel.

• Display Message - Display paper supply messages on the 
control panel. Printing is impossible until paper is supplied.

• Use Nearest Size (Adjust to Fit) - Selects the nearest paper 
size and automatically adjusts the image size as necessary.

• Use Nearest Size (No Zoom) - Selects the nearest paper size 
and prints the same size as the image.

• Use Larger Size (Adjust to Fit) - Selects paper larger than 
the original and automatically adjusts the image size as 
necessary.

• Use Larger Size (No Zoom) - Selects paper larger than the 
original and prints the same size as the image.

• Feed from Bypass Tray - Feed from bypass tray.

Print Mixed Size Originals Controls the orientation of the second-side image when printing 
double-sided.

Available Printer Memory Enter the amount of usable printer memory (in KB) in the Edit box. 
Usually, it is not necessary to change this.

Available Font Cache Enter the amount of memory available for the font cache (in KB) in 
the Edit box. Usually, it is not necessary to change this.

Account Mode Specifies if all users or only System Administrators can change 
authentication related settings.
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Options tab

This section describes the settings in the Options tab. 

Select the items in Hardware Options and change them in the 
Settings box below. 

NOTE: You can restore defaults by clicking [Restore Default].

Hardware Options

High Capacity Feeder Select "Available" if the High Capacity Feeder has been installed.

Hole Puncher Setup Specify the number of holes to punch on the paper. Select from "2 
Holes/4 Holes" or "2 Holes/3 Holes."
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Tri-Folding Output Tray Select "Available" if the Tri-Fold Output Tray is installed.

Booklet Output Tray Select "Available" if the Booklet Tray is installed.

Switch Paper Size (8K/16K) Indicate your language preference to enable the set of 8K and 16K 
paper sizes that is best suited to your needs. If you select 
"Traditional Chinese," the dimensions of the 8K and 16K paper 
sizes are 267 x 388mm and 194 x 267mm respectively. If you 
select "Simplified Chinese," the dimensions will be 270 x 390mm 
and 195 x 270mm respectively.

NOTE: If "AB Series (8K/16K)" is not selected in "Paper Size 
Settings," both sets of 8K and 16K paper sizes will not be 
available despite the setting specified here.

Memory The built-in memory is 512MB.

Output Settings tab

This section describes the settings in the Output Settings tab. 

NOTE: You can restore defaults by clicking [Restore Defaults].
Xerox 4110/4590 PostScr ipt  User Guide2-14



2. Windows Me
Job Type

You can specify the print function for Secure Print, Sample Print, 
and Delayed Print.

Secure Print temporarily stores print jobs in the printer and then 
prints them when print instructions are received from the control 
panel.

Sample Print outputs only one copy when multiple copies are 
specified. If there is no problem, the remaining sets can be 
printed.

Delayed Print temporarily stores print jobs in the printer and then 
prints them at the scheduled time.

To use Secure Print, Sample Print, or Delayed Print feature, input 
the User ID and password for Print Type in the "Output Settings" 
tab. The password entered appears as asterisks(*).

Normal Print Select when you do not want to output secure prints, sample 
prints, or delayed prints.

Secure Print Select when you want to output secure prints.

Sample Print Select when you want to output sample prints.

The Collated setting must be selected in the Page Setup tab 
when using Print Type.

Delayed Print Select when you want to output delayed prints.

See the On-line Help for details on the operation of the printer.

User ID Displays the User ID for Job Type. The user ID displayed is the 
User ID specified on the Configuration tab. This option can only be 
selected when the setting on the Configuration tab has been 
completed. This is a display-only item and cannot be changed 
here.

Password Displays password for Secure Print password specified in the 
Configuration tab. Each digit that you enter appears as an asterisk 
(*). This option can only be selected when the setting on the 
Configuration tab has been completed. This is a display-only item 
and cannot be changed here.
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Retrieve Document Name Select the method of specifying the document name. If you have 
selected Auto Retrieve, the valid document name can be up to 24 
alphanumeric characters.

Document Name When “Enter Document Name” is selected in the Retrieve 
Document Name list, a document name up to 24 alphanumeric 
characters can be specified.

Start Print Time Specifies the time when a Delayed Print job will be printed. Place 
the cursor in the hour or minute box and press the up or down 
triangle to specify the start time. You can also set the time by 
entering the time directly into the boxes. The default setting is 
00:00.

Miscellaneous settings

Output Size Selects the size of the paper used for output. The output is 
automatically enlarged or reduced, depending on the paper size 
selected here and the paper size selected in the Paper tab.

• For example, when you select [B5] in Paper Size on the Paper 
tab, and select [A4] as the Output Size, the output is 
automatically enlarged and printed.

• When you select [None], the job is printed based on the Paper 
Size selected in the application.

Banner Sheet Specifies whether or not to add a banner sheet to printed output.

• When [Use Printer Settings] is selected, the printer settings 
are used.

• When [Printer Start Page] is selected, outputs the banner 
sheet using the start-sheet.

E-mail Job Confirmation Specifies whether or not to use the Mail Notify feature to notify the 
end of the print job via e-mail. Default is [Off].

E-Mail Address Specifies the e-mail address for the Mail Notify feature.
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Display warning message
about Output Settings

When printing, the printer driver checks whether the Output Size 
setting conflicts with other settings.

• When this is activated, a conflict dialog box appears if there is 
non-conformity during printing. Check the content of the dialog 
box and resolve the conflicting function to continue printing.

• When this is inactive, no conflict dialog box appears, but the 
conflicting setting is automatically resolved and printing 
continues.

Image Rotation (180deg) Set the checkbox to rotate the prints by 180°. Default is [Off].
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How to use help

To get help on a feature or function, click the [Help] button; an 
explanation of the current tab appears as Help information.
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3. Windows NT 4.0

This chapter contains information on:

• The software included for Windows NT 4.0

• Hardware and software requirements on page 3-2

• Adobe PS driver installation on page 3-2

• Print driver device options and print settings on page 3-8

About the software

This section describes the software for Windows NT 4.0 that is 
included on the PostScript Driver Library CD-ROM.

Bundled software

The following items are included in the “PS\NT40”, 
“Utility\ATM\NT40”, and “Utility\Sfonts\NT40” folders on the CD-
ROM. Please read the “Readme.txt” file which contains cautionary 
notes about how to use the printer driver.

Xerox 4110/4590 PS Printer
Driver (ver. 5.2.2) and PPD

files

Xerox 4110/4590 PostScript driver and PPD files (for Windows NT 
4.0).

ATM (Adobe Type Manager,
ver. 4.0)

Helps you to install typefaces and activate and manage your fonts.

Adobe Screen Fonts
(TrueType/PostScript)

Includes 136 screen fonts (19 TrueType fonts and 117 PostScript 
fonts), which are compatible with the printer fonts. ATM is used to 
install the PostScript screen fonts. When using these fonts to print, 
it is recommended that you use the Adobe PostScript (5.2.2) 
printer driver.

Adobe Acrobat Reader Allows you to view and print PDF files on all major computing 
platforms.
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Hardware/software requirements

The minimum system requirements for the Windows NT 4.0 
printer driver are described below.

Computer System Personal computer which can run the Windows NT 4.0 operating 
system

Basic Software Windows NT Workstation 4.0 / Windows NT Server 4.0 (Service 
Pack 6a or later)

The Xerox 4110/4590 PS Printer Driver

KEY POINT: When installing the printer driver, ensure that you 
select the correct one (either 4110 or 4590).

Install the Xerox 4110/4590 PS 5.2.2 printer driver onto Windows 
NT by following the procedure below.

It is possible to cancel installation of the printer driver by clicking 
[Cancel] in the dialog box displayed during installation. You can 
also click [Back] to delete the settings in that dialog box and return 
to the previous dialog box.

Installation procedure

1. Start Windows NT 4.0.

NOTE: Log on as a Power User group member or an 
Administrator. Refer to the Windows NT 4.0 documentation for 
details about the Power User group.

2. On the Start menu, point to Settings and click [Printers].

3. In the Printer window, double-click [Add Printer].

4. Select how the printer is connected to the computer and click 
[Next]. Select [My Computer] if the printer is connected directly 
to the computer or to the network in the TCP/IP(LPD) 
environment. Select [Network printer server] in other cases. 
The following is an example of a local printer.
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NOTE: Specify the target printer in the Connect to Printer 
dialog box if you selected [Network printer server].

5. Select the port you are using and click [Next]. 

6. Insert the PostScript Driver Library CD-ROM in the CD-ROM 
drive.
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7. Click [Have Disk]. 

8. Enter “Drive Name:\PrinterDriver\NT40” in the “Copy 
manufacturer’s files from:” box and click [OK].

In this example, we have used “D:” as the CD-ROM drive. If 
you are using a different drive for the CD-ROM, specify 
accordingly.

NOTE: Click [Browse] to specify a folder on the CD-ROM.
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9. Select your printer model from the Printers list and click [Next].

10.Enter the printer name, specify if you want to use the printer 
as the default printer, and click [Next].
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11.Select [Not shared] and click [Next].

We recommend that you install the driver on each computer 
with the procedure appropriate to the operating system.

12.Specify whether or not to print a test page, then click [Finish].

Installation begins.
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13.Read the End User License Agreement and click [Agree].

When you click [Disagree], see page 3-8 for details.

14.Confirm that the printer has been added in the Printers 
window.

• This completes installation of the printer driver. Remove 
the CD-ROM from the drive.

• See “Device options and print settings” on page 3-8. to 
configure the printer.

• Store your CD-ROM in a safe place.
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If you click Disagree in the License Agreement

When you click [Disagree] in the End User License Agreement, 
the following dialog box appears.

• Click [No] to return to Step 13. and continue the operation.

• Click [Yes] to cancel the installation. A printer is added in the 
Printers window, but the printer driver is not installed properly.

• Select the printer and click [Properties] on the File menu. The 
Reinstallation tab is added to the printer driver properties 
dialog box. Follow the directions on that tab.

• When you finish reinstalling, continue to the "Device options 
and print settings" section to set up the printer.

Device options and print settings

This section describes printer specific settings for printer driver 
properties and document presets:

• Installable Options in the Device Settings Tab

• Configuration Tab

• Detail Settings Tab

• Paper/Output Tab

NOTE: You can also refer to Help for explanations of these 
settings. See “Device settings tab” on page 3-9..

To view the Device Settings or Configuration tabs, select the 
printer icon in the Printers window, then click Properties on the File 
menu.

To view the Advanced or Output Settings tabs, select the printer 
icon in the Printers window, then click Document Defaults on the 
File menu.
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Device settings tab

This section describes Installable Options in the Device Settings 
tab. To print correctly, it is necessary to make the appropriate 
settings in this tab.

Select the items in Installable Options and change the settings in 
the menu that appears on the right.
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Settings

High Capacity Feeder Select "Available" if the High Capacity Feeder has been installed.

Hole Punch Specify the number of holes to punch on the paper. Select from "2 
Holes/4 Holes" or "2 Holes/3 Holes."

Tri-Folding Output Tray Select "Available" if the Tri-Fold Output Tray is installed.

Booklet Output Tray Select "Available" if the Booklet Tray is installed.

Paper Size Settings Specify the paper size group for different locales to enable the 
selection of paper sizes common to that locale. The following 
groups of paper size categorized by locale are available: "AB 
Series," "AB Series (8K / 16K)," "AB Series (8 x 13")," "AB Series 
(8 x 13" / 8 x 14")," and "Inch Series." As the paper size settings 
will be set automatically in accordance with the relevant locale, it 
is usually not necessary to change this setting.

Switch Paper Size (8K/16K) Indicate your language preference to enable the set of 8K and 16K 
paper sizes that is best suited to your needs. If you select 
"Traditional Chinese," the dimensions of the 8K and 16K paper 
sizes are 267 x 388mm and 194 x 267mm respectively. If you 
select "Simplified Chinese," the dimensions will be 270 x 390mm 
and 195 x 270mm respectively.

NOTE: If "AB Series (8K/16K)" is not selected in "Paper Size 
Settings," both sets of 8K and 16K paper sizes will not be 
available despite the setting specified here.
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Configuration tab

This section describes the settings of the Configuration tab. 

NOTE: You can restore defaults by clicking [Restore Defaults].
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Settings

Account Mode Specifies if all users or only System Administrators can change 
authentication related settings.

Detailed User Settings Sets the authentication information.

• Use Default User Settings - The values set in this feature are 
used as the authentication parameters.

• Specify Job Owner Name - Select how to specify User ID.

– Job Owner Name - Enter a User ID.

– Password - Enter a Password that matches the User ID.

– Account ID - Enter an Account ID.

– Billing ID - Enter a User ID for Charge Print.

– Password - Enter a Password that matches the Billing ID.

• Prompt User for Settings - Select this feature to display the 
[Enter User Details] dialog-box each time you start printing. 
The user is then required to enter authentication information 
such as their User ID.

– Display Previous User Details - Select to store the user 
details entered in the [Enter User Details] dialog-box and 
display the details in the box as a default next time.

– Hide User ID(***) - Select to specify whether a user ID is 
to be displayed or hidden when it is entered.

– Hide Account ID(***) - Select to specify whether an 
account ID is to be displayed or hidden when it is entered.

High Speed Printing Set this feature to make improvements in print speed, when using 
an application that generates PostScript directly.

Get Information from
Printer

Click [Get Information from Printer] when the machine is used as a 
network printer to verify the printer option installation state using 
the print port to which the printer is connected. This information is 
also reflected in the Hardware Options setting.
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Detailed Settings tab

This section describes the settings of the Detail Settings 
tab. Select the items from Printer Features and change them on 
the menu displayed to the right. 

Settings

Bypass Feed Orientation Specifies the paper orientation when printing from the bypass tray. 
When feeding the short edge of the paper first, select 
[Landscape]. When feeding the long edge of the paper, select 
[Portrait].

Offset Stacking The position of individual jobs or sets of copies are shifted to either 
side of the output tray to enable easy separation.
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Covers Specifies the settings related to Covers.

NOTE: The cover cannot be printed.

• Front Cover - Specify whether to add a front cover to the 
printouts. Select the paper tray for feeding the front cover 
sheets.

• Back Cover - Specify whether to add back cover to the 
printouts. Select the paper tray for feeding the back cover 
sheets.

• Tray 8 - Specify Tab Stock - Specify whether tab stock is 
being loaded in tray 8. Select either "Plain" or "Tab Stock."

Transparencies Set up separators to be inserted between transparencies.

• Feed Separators from - Specifies the paper tray that 
transparency dividers are to be fed from. When [Auto] is 
selected, the tray set on the machine is used as the feed 
destination.

• Print on Separators - Specifies whether or not to print on the 
transparency dividers as well as the transparency.

Images Set up image-related settings.

• Print Mode - Specifies whether to give priority to the print 
speed or the image quality.

• Halftone - Select the halftone settings for printing.

• Select [Fine Dots] for the small size halftone dot commonly 
used in PostScript.

• Select [Thick Dots] for coarser dots than the Fine Dots setting.

• Select [Type 3] for the same halftone setting that is used in 
PCL.

• Image Enhancement - Specifies whether or not to use the 
Image Enhancement function. Selecting [On] smooths out 
boundaries when printing. This reduces jagged edges by 
artificially increasing the resolution of the image. When printing 
a bitmapped image composed of coarse halftone dots, smooth 
color or grayscale gradation is impossible in certain situations. 
In this case, select [Off].
Xerox 4110/4590 PostScr ipt  User Guide3-14



3.  Windows NT 4.0
Details Set up other printing options.

• Image Rotation (180deg) - Set the checkbox to rotate the 
prints by 180°. Default is [Off].

• Double Print - Enable this feature to repeatedly print one 
page twice on a paper with a bigger size than the original. You 
can use Double Print feature if you have set the zoom ratio to 
100% with the following paper size and output size settings. 

• Paper Size • Output Size

• A4 • A3

• A5 • A4

• B5 • B4

• Folio (8.5 x 11") • Ledger (11 x 17")

• Skip Blank Pages - Specify whether to skip blank pages when 
printing documents that consist of blank pages.

• Draft Mode - Specifies whether or not to reduce the amount of 
toner used when printing drafts. When [On] is selected, the 
overall printed page becomes lighter. This is best for printing 
documents when high print quality is not necessary.

• Banner Sheet - Specifies whether or not to add a banner 
sheet to printed output.

• When [Use Printer Settings] is selected, the printer settings 
are used.

• When [Printer Start Page] is selected, outputs the banner 
sheet using the start-sheet.

• E-mail Job Confirmation - Specifies whether or not to use the 
Mail Notify feature to notify the end of the print job via e-mail. 
Default is [Off].

– Enter Address - Specifies the e-mail address for the Mail 
Notify feature.

• Substitute Tray - Specifies what action to take when the 
paper for the print size is not loaded in the machine.

• Custom Paper Auto Orientation - Specifies whether or not to 
correct the orientation of the custom paper.

• Print Mixed Size Originals - Controls the orientation of the 
second-side image when printing double-sided.

About Click the "About" button to display the "About" dialog box. The 
version number and copyright description for this print driver will 
be displayed.

Help To display Help, click the "Contents" button at the top left of the 
screen. You can find detailed descriptions on the content items in 
Help or enter keywords to search for needed information.
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Paper/Output tab

This section describes the Paper/Output settings tab.

NOTE: You can restore defaults by clicking [Restore Defaults].
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Settings

Job Type You can select Normal Print or specify the print function for Secure 
Print, Sample Print, and Delayed Print. To use Secure Print, 
Sample Print, or Delayed Print feature, input the User ID and 
password for Print Type in the Configuration tab. The password 
entered appears as asterisks(*).

• Normal Print - Select when you do not want to output secure 
prints, sample prints, or delayed prints.

• Secure Print - Secure Print temporarily stores print jobs in the 
printer and then prints them when print instructions are 
received from the control panel. Select when you want to 
output secure prints.

• Sample Print - Sample Print outputs only one copy when 
multiple copies are specified. If there is no problem, the 
remaining sets can be printed. Select when you want to 
output sample prints.

NOTE: The Collated setting must be selected in the Paper/Output 
tab when using Print Type.

• Delayed Print - Delayed Print temporarily stores print jobs in 
the printer, and then prints them at the scheduled time. Select 
when you want to output delayed prints.

See the On-line Help for details on the operation of the printer.

– User ID - Displays the User ID for Job Type. The user ID 
displayed is the User ID specified on the Configuration tab. 
This option can only be selected when the setting on the 
Configuration tab has been completed. This is a display-
only item and cannot be changed here.

– Password - Displays the password for Secure Print as 
specified in the Configuration tab. Each digit entered 
appears as an asterisk (*). This option can only be 
selected when the setting on the Configuration tab has 
been completed. This is a display-only item and cannot be 
changed here.

– Retrieve Document Name - Select the method for 
specifying the document name. If you have selected Auto 
Retrieve, the valid document name can be up to 24 
alphanumeric characters can be specified.
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– Document Name - When “Enter Document Name” is 
selected in the Retrieve Document Name list, a document 
name up to 24 alphanumeric characters.

– Start Print Time - Specifies the time when a Delayed Print 
job will be printed. Place the cursor in the hour or minute 
box and press the up or down triangle to specify the start 
time. You can also set the time by entering the time directly 
into the boxes. The default setting is 00:00.

Paper Size Select the paper size of the file to be printed.

Paper Source Select the paper tray to be used for printing.

Paper Type Select the paper type to be used for printing.

2-sided Print Performs 2-sided printing. Select either "Flip on long edge" or 
"Flip on short edge" for 2-sided printing. Select any one of these 
options as required. In "Flip on long edge" and "Flip on short 
edge," the side 1 and side 2 images are printed such that when 
rotated with the long edge and short edge respectively as axis, 
they are pointing in the same direction.

Stapling Select the stapling position. The stapling position specified is 
based on the printing data. If the stapling position is incorrect, 
refer to the PostScript Kit manual and adjust the Stapling setting 
accordingly. 

NOTE: Limitations for stapling mixed size output may apply. 
Stapling for mixed size output is not available in the following 
situations:

• When a setting other than "1 Up" is selected for "Multiple-Up" 
in the "Layout" tab 

• When a setting other than "Off" is selected for "Booklet 
Creation" in the "Layout" tab 

• When "Double Print" is set to "On" under "Details" in the 
"Detailed Settings" tab 

• When a size other than "A3," "B4," "A4”, "B5”,"8.5 x 11," "11 x 
17," "16K (267 x 194mm) / 8K (267 x 388mm)," and "16K (270 
x 195mm) / 8K (270 x 390mm)" is selected

• When a setting other than "None" or "On (Mixed Sizes)" is 
selected for "Hole Punching" in the "Paper / Output" tab
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Hole Punching Select the punching position. The holes are made based on the 
output orientation of the paper. As a result, the holes may not be 
punched correctly depending on the position of the image.

NOTE: Moreover, there are limitations for punching holes on 
mixed size output. Hole punching for mixed size output is not 
available in the following situations:

• When a setting other than "1 Up" is selected for "Multiple-Up" 
in the "Layout" tab 

• When a setting other than "Off" is selected for "Booklet 
Creation" in the "Layout" tab 

• When "Double Print" is set to "On" under "Details" in the 
"Detailed Settings" tab 

• When a size other than "A3," "B4," "A4," "B5," "8.5 x 11," "11 x 
17," "16K (267 x 194mm) / 8K (267 x 388mm)," and "16K (270 
x 195mm) / 8K (270 x 390mm)" is selected

• When a setting other than "None," "1 Staple (Mixed Sizes)," or 
"2 Staples (Mixed Sizes)" is selected for "Stapling" in the 
"Paper / Output" tab

Hole Punching - Specify the number of holes to punch. Select 
from "Use Printer Settings," "2 Holes," or "4 Holes."

NOTE: If "3 Holes" is selected for "Hole Puncher Setup" on 
the "Device Settings" tab, only "Use Printer Settings" will be 
available for selection. "Device Settings" tab is displayed on 
the print driver screen when "Properties" is selected from the 
menu of the printer icon in the "Printers" folder.

Stapling/Hole Punching for
Mixed Size Output

Click this button to display the "Stapling/Hole Punching for Mixed 
Size Output" dialog box. You can specify the settings for stapling 
or punching for mixed sized documents.

NOTE: There are limitations for stapling mixed size output. 
Stapling for mixed size output is not available in the following 
situations:

• When a setting other than "1 Up" is selected for "Multiple-Up" 
in the "Layout" tab 

• When a setting other than "Off" is selected for "Print Booklet" 
in the "Layout" tab 

• When "Double Print" is set to "On" under "Details" in the 
"Detailed Settings" tab 
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• When a size other than "A3," "B4," "A4," "B5," "8.5 x 11," "11 x 
17," "16K (267 x 194mm) / 8K (267 x 388mm)," and "16K (270 
x 195mm) / 8K (270 x 390mm)" is selected

• When a setting other than "None" or "On (Mixed Sizes)" is 
selected for "Hole Punching" in the "Paper / Output" tab 

• When a setting other than "None," "1 Staple (Mixed Sizes)," or 
"2 Staples (Mixed Sizes)" is selected for "Stapling" in the 
"Paper / Output" tab

– Stapling - Specify the position to staple mixed size 
originals. Select "1 Staple (Mixed Sizes)" or "2 Staples 
(Mixed Sizes)."

KEY POINT: If "Double Print" is set to "On" under "Details" in 
the "Detailed Settings" tab, the Stapling feature will not be 
available. 

– Hole Punching - Select "On (Mixed Sizes)" to enable hole 
punching feature for mixed size originals.

KEY POINT:When "Double Print" is set to "On" under "Details" 
in the "Detailed Settings" tab, Hole Punching feature will not 
be available.

– Hole Punching - Specify the number of holes to punch. 
Select from "Use Printer Settings," "2 Holes" or "4 Holes."

NOTE: If "3 Holes" is selected in "Hole Punching Settings" on 
the "Device Settings" tab, only "Use Printer Settings" will be 
available for selection.

Folding (Z Folding) If Tri-Fold Output Tray is installed, select the check box to perform 
Z folding for Mixed Size Documents.

• Image Rotation (180deg) - Turn the mixed size originals by 
180 degrees and print. 

• Select "Portrait," "Landscape," or "Portrait & Landscape (For 
envelopes)."

If "2 Up" or more is selected in "Multiple-Up" on the "Layout" 
tab, individual pages will be rotated and printed. 
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• First Page - Specifies the "Paper Size" and "Image 
Orientation" of the first page of the mixed size document.

– Paper Size (First Page) - Specifies the paper size of the 
first page of the document.

The paper size combinations for mixed size originals are 
"A3 and A4," "B4 and B5," "8.5 x 11" and 11 x 17," " and 
"16K and 8K."  "Paper Size" of the "Mixed Pages" will 
automatically be specified based on this setting.

– Image Orientation (First Page) - Specifies the image 
orientation of the first page of the document.

Select either "Portrait" or "Landscape."

• Mixed Pages - Specifies the "Paper Size" and "Image 
Orientation" of the mixed pages.

– Paper Size (Mixed Pages) - Displays the paper size of the 
mixed pages.

The paper size will automatically be specified based on the 
"Paper Size" settings of the first page.

– Image Orientation (Mixed Pages) - Specifies the image 
orientation of the mixed pages.

Select either "Portrait" or "Landscape."

Folding Select the folding method.

NOTE 1: "Z Fold," "Z Tri-Fold," and "C Tri-Fold" will be available 
when the Tri-Fold Output Tray is installed and set up in the "Device 
Settings" tab.

NOTE 2: "Bi-Fold" is available when a Booklet Tray is installed and 
set up in the "Device Settings" tab.

Output Destination Select the paper output destination. Select "Auto Select" or 
"Finisher Tray (Large Output)" from the "Output Destination" 
menu.

Printer Status Open the Web browser and connect to CentreWare Internet 
Services for the printer to display the printer status.

To use CentreWare Internet Services, you must set the Internet 
Services on the printer to "Start."
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Layout tab

This section describes the Layout tab settings tab.

NOTE: You can restore defaults by clicking [Restore Defaults].

Settings

Multi-Up Prints 2, 4, 6, 9 or 16 consecutive pages of the document on a 
single page of paper. This feature is known as "Multiple-Up."

Select the number of pages to be printed on a single page from "2 
Up," "4 Up," "6 Up," "9 Up," and "16 Up." The area of the paper to 
be printed is divided equally among the pages and the pages will 
be automatically rotated and reduced to fit into the page.

KEY POINT: If setting other than "Off" is selected in "Booklet 
Creation" on the "Layout" tab, only "1 Up" can be selected. You 
can check the result of the change in setting on the preview image 
at the top right of the screen.
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Image Border Select this check box to add a border around every page of the 
original document when printed in Multiple-Up layout.

Print Booklet Specify the assembling and finishing methods for booklet creation. 

You can check the result of the change in setting on the preview 
image at the top right of the screen.

KEY POINT: "Booklet Creation" feature will only be available if 
"Automatically Select" or "Auto Paper Select (Type)" is selected in 
"Paper Source" on the "Paper/Output" tab.

Output Size for Booklet Specify the output size for booklet creation printing.

NOTE: When "Booklet Creation" is selected, only "AutoSelect 
Tray" and "Auto Paper Select (Type)" are available in "Paper 
Source" on the "Paper/Output" tab. Conversely, "Booklet Creation" 
feature is only available when "Automatically Select" or "Auto 
Paper Select (Type)" is selected in "Paper Source."

Booklet Subsets Specify the number of sheets in each subset when printing booklet 
in subsets. Select from "None," or "Every Sheet" to "Every "20 
Sheets."

Margin Shift Clicking this button displays the "Margins" dialog box. Enter the 
position and the extent of the margin shift on the paper.

• Position - Specifies the margin shift (binding margin) 
position. The margin can be added to the left, right, top, or 
bottom of the paper. The margin positions change according to 
the paper orientation.

KEY POINT: If setting other than "Off" is selected in "Print 
Booklet" on the "Layout" tab, only "No Shift" will be available in 
"Position."

• Side 1 - Specifies the margin on side 1 of the paper when 
using the "Margin Shift" function.

– You can specify any value between 0 and 50 mm in units 
of 1mm using the keyboard or the up and down arrows.

– You can use the keyboard or the up and down arrows to 
specify a value.
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• Side 2 - Specifies the margin on side 2 of the paper when 
using the "Margin Shift" function in 2-sided printing.

– The margin shift position for side 2 is automatically set so 
that the margin is added to the same edge as side 1.

– You can specify any value between 0 and 50 mm in units 
of 1mm using the keyboard or the up and down arrows.

– You can use the keyboard or the up and down arrows to 
specify a value.

Printer Status Open the Web browser and connect to CentreWare Internet 
Services for the printer to display the printer status.

To use CentreWare Internet Services, you must set the Internet 
Services on the printer to "Start."

NOTE: This feature cannot be used when the printer is used as a 
local printer.
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4. Windows 2000/XP and Windows 
Server 2003

This chapter contains information on:

• The software included for Windows 2000, Windows XP, and 
Windows Server 2003

• Hardware and software requirements on page 4-2

• Adobe PS driver installation on page 4-3

• Print driver device options and print settings on page 4-10

About the software

This section describes the software for Windows 2000, Windows 
XP, and Windows Server 2003 included with the PostScript Driver 
Library CD-ROM.

Bundled software

The following items are included on the CD-ROM and are 
necessary when using the printer on Windows 2000, Windows XP 
and Windows Server 2003. Please read the “Readme.txt” file 
which contains cautionary notes about how to use the printer 
driver.

Xerox 4110/4590 PS Driver
and PPD files

Xerox 4110/4590 PS Driver and PPD files (for Windows 2000, 
Windows XP and Windows Server 2003).

Adobe Acrobat Reader Allows you to view and print PDF files on all major computing 
platforms.
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Hardware/software requirements

The minimum system requirements for the Windows 2000, 
Windows XP, and Windows Server 2003 printer driver are 
described below.

Computer System Personal computer which can run the Windows 2000, Windows 
XP, or Windows Server 2003 operating system.

Basic Software • Windows 2000 Professional

• Windows 2000 Server

• Windows 2000 Advanced Server

• Windows XP Professional Edition

• Windows XP Home Edition

• Windows Server 2003

The Xerox 4110/4590 PS Printer Driver 

KEY POINT: When installing the printer driver, ensure that you 
select the correct one (either 4110 or 4590).

Install Xerox 4110/4590 PS printer driver onto Windows 2000, 
Windows XP, and Windows Server 2003 by following the 
procedure below.

This section describes how to install the printer driver for Windows 
2000, as an example.

NOTE 1: It is possible to cancel installation of the printer driver by 
clicking [Cancel] in the dialog box displayed during installation. 
You can also click [Back] to delete the settings in that dialog box 
and return to the previous dialog box.

NOTE 2: If you want to set up Port 9100, refer to the System 
Administration Guide.
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Installation Procedure

1. Start Windows 2000.

NOTE: Log on as a Power User group member or an 
Administrator. Refer to the Windows 2000 documentation for 
details about the Power User group.

2. On the Start menu, point to Settings and click [Printers].

3. In the Printers window, double-click [Add Printer].

4. Click [Next]. 

5. Select how the printer is connected to the computer and click 
[Next]. 

Select [Local printer] if the printer is connected directly to the 
computer or to the network in the TCP/IP(LPD) environment. 
Otherwise, select [Network printer]. The following is an 
example of a Local printer.

NOTE 1: When you select [Local printer], deselect the 
“Automatically detect and install my Plug and Play printer” 
check box.
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NOTE 2: Specify the target printer in the Connect to printer 
dialog box if you selected [Network printer].

6. Select the port you are using and click [Next].

When the printer is connected in the TCP/IP(LPD) 
environment:

a. Click [Create a new port].

b. Select Standard TCP/IP Port in the Type list and click 
[Next].
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c. Click [Next].

d. Enter the IP address of the printer in Printer Name or IP 
Address, then click [Next]. 

e. Click [Finish] in the dialog box that will be displayed.

7. Insert the PostScript Driver Library CD-ROM in the CD-ROM 
drive. 
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8. Click [Have Disk]. 

9. Enter “Drive Name:\PrinterDriver\Win2K_XP” in the “Copy 
manufacturer’s files from:” box and click [OK].

In this example, we have used “D:” as the CD-ROM drive. If 
you are using a different drive for the CD-ROM, specify 
accordingly.

NOTE: Click [Browse] to specify a folder on the CD-ROM. 
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10.Select your printer model from the Printers list and click [Next]. 

11.Enter the printer name, set whether you want to use it as the 
default printer, and click [Next]. 
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12.Select [Do not share this printer] and click [Next]. 

We recommend that you install the driver on each computer 
with the procedure appropriate to the operating system. 

13.Specify whether or not to print a test page, then click [Next]. 
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14.Click [Finish]. 

NOTE: If the dialog box “Digital Signature Not Found” 
appears, click [Yes] to continue the installation.

Installation begins.

15.Confirm that the printer has been added in the Printers 
window. 

• This completes the installation of the printer driver. 
Remove the CD-ROM from the drive.

• See “Device options and print settings” on page 4-10 to 
configure the printer. 

• Store your CD-ROM in a safe place.
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Device options and print settings

This section describes printer specific settings for printer driver 
properties. For other items, refer to the Help.

• Installable Options in the Device Settings Tab

• Configuration Tab

• Detail Settings Tab

• Paper/Output Settings Tab

NOTE: You can also refer to Help for explanations of these 
settings. See “Device Settings tab” on page 4-11. 

To view the Device Settings or Configuration tabs, select the 
printer in the Printers window, then click [Properties] on the File 
menu.

To view the Advanced Options dialog box, select the printer in the 
Printers window, then click [Printing Preferences] on the File 
menu. Click [Advanced] in the Layout screen. 

To view the Output Settings tab, select the printer in the Printers 
window, then click [Printing Preferences] on the File menu.
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Device Settings tab

This section describes installable options in the Device Settings 
tab. To print correctly, it is necessary to make the appropriate 
settings in this tab.

Select the items in Installable Options area and change the 
settings in the menu that appears on the right.
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Settings

High Capacity Feeder Select "Available" if the High Capacity Feeder has been installed.

Hole Punch Specify the number of holes to punch on the paper. Select from "2 
Holes/4 Holes" or "2 Holes/3 Holes."

Tri-Folding Output Tray Select "Available" if the Tri-Fold Output Tray is installed.

Booklet Output Tray Select "Available" if the Booklet Tray is installed.

Paper Size Settings Specify the paper size group for different locales to enable the 
selection of paper sizes common to that locale. The following 
groups of paper size categorized by locale are available: "AB 
Series," "AB Series (8K / 16K)," "AB Series 
(8 x 13")," "AB Series (8 x 13" / 8 x 14")," and "Inch Series." As the 
paper size settings will be set automatically in accordance with the 
relevant locale, it is usually not necessary to change this setting.

Switch Paper Size (8K/16K) Indicate your language preference to enable the set of 8K and 16K 
paper sizes that is best suited to your needs. If you select 
"Traditional Chinese," the dimensions of the 8K and 16K paper 
sizes are 267 x 388mm and 194 x 267mm respectively. If you 
select "Simplified Chinese," the dimensions will be 270 x 390mm 
and 195 x 270mm respectively.

NOTE: If "AB Series (8K/16K)" is not selected in "Paper Size 
Settings," both sets of 8K and 16K paper sizes will not be 
available despite the setting specified here.
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Configuration tab

This section describes the settings of the Configuration tab. 

NOTE: You can restore defaults by clicking [Restore Defaults].
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Settings

Account Mode Specifies if all users or only System Administrators can change 
authentication related settings.

Detailed User Settings Sets the authentication information.

• Use Default User Settings - The values set in this feature are 
used as the authentication parameters.

– Specify Job Owner Name - Select how to specify User 
ID.

– Job Owner Name - Enter a User ID.

– Password - Enter a Password that matches the User ID.

– Account ID - Enter an Account ID.

– Billing ID - Enter a User ID for Charge Print.

– Password - Enter a Password that matches the Billing ID.

• Prompt User for Settings - Select this feature to display the 
[Enter User Details] dialog-box each time you start printing. 
The user is then required to enter authentication information 
such as their User ID.

– Display Previous User Details - Select to store the user 
details entered in the [Enter User Details] dialog-box, and 
display the details in the box as a default next time.

– Hide User ID(***) - Select to specify whether an account 
ID is to be displayed or hidden when it is entered.

– Hide Account ID(***) - Select to specify whether an 
account ID is to be displayed or hidden when it is entered.

High Speed Printing Set this feature to make improvements in print speed, when using 
an application that generates PostScript directly.

Get Information from
Printer

Clicking [Get Information from Printer] when the machine is used 
as a network printer verifies the printer option installation state 
using the print port to which the printer is connected, and reflects 
this in the Hardware Options setting.
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Detailed Settings tab

This section describes the settings of the Detail Settings tab.

Select the items from Printer Features and change them on the 
menu displayed to the right. 

Settings

Bypass Feed Orientation Specifies the paper orientation when printing from the bypass tray. 
When feeding the short edge of the paper first, select 
[Landscape]. When feeding the long edge of the paper, select 
[Portrait].

Offset Stacking The position of individual jobs or sets of copies are shifted to either 
side of the output tray to enable easy separation.
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Covers Specifies the settings related to Covers.

NOTE: The cover cannot be printed.

• Front Cover - Specify whether to add a front cover to the 
printouts. Select the paper tray for feeding the front cover 
sheets.

• Back Cover - Specify whether to add a back cover to the 
printouts. Select the paper tray for feeding the back cover 
sheets.

• Tray 8 - Specify Tab Stock - Specify whether tab stock is 
being loaded in tray 8. Select either "Plain" or "Tab Stock."

Transparencies Set up separators to be inserted between transparencies.

• Feed Separators from - Specifies the paper tray that 
transparency dividers are to be fed from. When [Auto] is 
selected, the tray set on the machine is used as the feed 
destination.

• Print on Separators - Specifies whether or not to print on the 
transparency dividers as well as the transparency.

Images Set up image-related settings.

• Print Mode - Specifies whether to give priority to the print 
speed or the image quality.

• Halftone - Select the halftone settings for printing.

– Select [Fine Dots] for the small size halftone dot commonly 
used in PostScript.

– Select [Thick Dots] for coarser dots than the Fine Dots 
setting.

– Select [Type 3] for the same halftone setting that is used in 
PCL.

• Image Enhancement - Specifies whether or not to use the 
Image Enhancement function. Selecting [On] smooths out 
boundaries when printing. This reduces jagged edges by 
artificially increasing the resolution of the image. When printing 
a bitmapped image composed of coarse halftone dots, smooth 
color or grayscale gradation is impossible in certain situations. 
In this case, select [Off].
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Details Set up other printing options.

• Image Rotation (180deg) - Set the checkbox to rotate the 
prints by 180°. Default is [Off].

• Double Print - Enable this feature to repeatedly print one 
page twice on a paper with a bigger size than the original. You 
can use Double Print feature if you have set the zoom ratio to 
100% with the following paper size and output size settings. 

• Paper Size • Output Size

• A4 • A3

• A5 • A4

• B5 • B4

• Folio (8.5 x 11") • Ledger (11 x 17")

• Skip Blank Pages - Specify whether to skip blank pages when 
printing documents that consist of blank pages.

• Draft Mode - Specifies whether or not to reduce the amount of 
toner used when printing drafts. When [On] is selected, the 
overall printed page becomes lighter. This is best for printing 
documents when high print quality is not necessary.

• Banner Sheet - Specifies whether or not to add a banner 
sheet to printed output.

– When [Use Printer Settings] is selected, the printer 
settings are used.

– When [Printer Start Page] is selected, outputs the banner 
sheet using the start-sheet.

• E-mail Job Confirmation - Specifies whether or not to use the 
Mail Notify feature to notify the end of the print job via e-mail. 
Default is [Off].

Enter Address - Specifies the e-mail address for the Mail 
Notify feature.

• Substitute Tray - Specifies what action to take when the 
paper for the print size is not loaded in the machine.

• Tab Margin Shift - Selecting [On] shifts the image by 13 mm 
during printing on the printer, and prints text on the tab portion 
of the tab stock. When preparing a document, place text on the 
part of the document where the tab will be located (assuming 
that the entire image will be shifted by 13 mm).

The tab is on the side of the tab stock that is output first.

• Custom Paper Auto Orientation - Specifies whether or not to 
correct the orientation of the custom paper.

• Print Mixed Size Originals - Controls the orientation of the 
second-side image when printing double-sided.

About Click the "About" button to display the "About" dialog box. The 
version number and copyright description for this print driver will 
be displayed.
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Help To display Help, click the "Contents" button at the top left of the 
screen. You can find detailed descriptions on the content items in 
Help or enter keywords to search for needed information.

Paper/Output tab

This section describes the Paper/Output settings tab.

NOTE: You can restore defaults by clicking [Restore Defaults].
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Settings

Job Type You can select Normal Print or specify the print function for Secure 
Print, Sample Print, and Delayed Print. To use Secure Print, 
Sample Print, or Delayed Print feature, input the User ID and 
password for Print Type in the Configuration tab. The password 
entered appears as asterisks(*).

• Normal Print - Select when you do not want to output secure 
prints, sample prints, or delayed prints.

• Secure Print - Secure Print temporarily stores print jobs in the 
printer and then prints them when print instructions are 
received from the control panel. Select when you want to 
output secure prints.

– User ID - Displays the User ID for Job Type. The user ID 
displayed is the User ID specified on the Configuration tab. 
This option can only be selected when the setting on the 
Configuration tab has been completed. This is a display-
only item and cannot be changed here.

– Password - Displays the password for Secure Print as 
specified in the Configuration tab. Each digit entered 
appears as an asterisk (*). This option can only be 
selected when the setting on the Configuration tab has 
been completed. This is a display-only item and cannot be 
changed here.

– Retrieve Document Name - If [Auto Retrieve] is selected, 
the document name will be obtained from the application 
that sends the print command. No manual entry is allowed. 
Document names that exceed 24 characters are truncated.

– Document Name - When “Enter Document Name” is 
selected in the Retrieve Document Name list, a document 
name up to 24 alphanumeric characters.

• Sample Print - Sample Print outputs only one copy when 
multiple copies are specified. If there is no problem, the 
remaining sets can be printed. Select when you want to 
output sample prints.
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NOTE: The Collated setting must be selected in the Page Setup 
tab when using Print Type.

• Delayed Print - Delayed Print temporarily stores print jobs in 
the printer, and then prints them at the scheduled time. Select 
when you want to output delayed prints.

See the On-line Help for details on the operation of the printer.

– Start Print Time - Specifies the time when a Delayed Print 
job will be printed. Place the cursor in the hour or minute 
box and press the up or down triangle to specify the start 
time. You can also set the time by entering the time directly 
into the boxes. The default setting is 00:00.

Paper Size Select the paper size of the file to be printed.

Paper Source Select the paper tray to be used for printing.

Paper Type Select the paper type to be used for printing.

2-sided Print Performs 2-sided printing. Select either "Flip on long edge" or 
"Flip on short edge" for 2-sided printing. Select any one of these 
options as required. In "Flip on long edge" and "Flip on short 
edge," the side 1 and side 2 images are printed such that when 
rotated with the long edge and short edge respectively as axis, 
they are pointing in the same direction.

Stapling Select the stapling position. The stapling position specified is 
based on the printing data. If the stapling position is incorrect, 
refer to the PostScript Kit manual and adjust the Stapling setting 
accordingly. 

NOTE: Limitations for stapling mixed size output may apply. 
Stapling for mixed size output is not available in the following 
situations:

• When a setting other than "1 Up" is selected for "Multiple-Up" 
in the "Layout" tab 

• When a setting other than "Off" is selected for "Booklet 
Creation" in the "Layout" tab 

• When "Double Print" is set to "On" under "Details" in the 
"Detailed Settings" tab

• When a size other than "A3," "B4," "A4," "B5," "8.5 x 11," "11 x 
17," "16K (267 x 194mm) / 8K (267 x 388mm)," and "16K (270 
x 195mm) / 8K (270 x 390mm)" is selected

• When a setting other than "None" or "On (Mixed Sizes)" is 
selected for "Hole Punching" in the "Paper / Output" tab
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Hole Punching Select the punching position. The holes are made based on the 
output orientation of the paper. As a result, the holes may not be 
punched correctly depending on the position of the image.

NOTE: Moreover, there are limitations for punching holes on 
mixed size output. Hole punching for mixed size output is not 
available in the following situations:

• When a setting other than "1 Up" is selected for "Multiple-Up" 
in the "Layout" tab 

• When a setting other than "Off" is selected for "Booklet 
Creation" in the "Layout" tab 

• When "Double Print" is set to "On" under "Details" in the 
"Detailed Settings" tab 

• When a size other than "A3," "B4," "A4," "B5," "8.5 x 11," "11 x 
17," "16K (267 x 194mm) / 8K (267 x 388mm)," and "16K (270 
x 195mm) / 8K (270 x 390mm)" is selected

• When a setting other than "None," "1 Staple (Mixed Sizes)," or 
"2 Staples (Mixed Sizes)" is selected for "Stapling" in the 
"Paper / Output" tab

Hole Punching - Specify the number of holes to punch. Select 
from "Use Printer Settings," "2 Holes," or "4 Holes."

NOTE: If "3 Holes" is selected for "Hole Puncher Setup" on the 
"Device Settings" tab, only "Use Printer Settings" will be available 
for selection. "Device Settings" tab is displayed on the print driver 
screen when "Properties" is selected from the menu of the printer 
icon in the "Printers" folder.

Stapling/Hole Punching for
Mixed Size Output

Click this button to display the "Stapling/Hole Punching for Mixed 
Size Output" dialog box. You can specify the settings for stapling 
or punching for mixed sized documents.

NOTE: There are limitations for stapling mixed size output. 
Stapling for mixed size output is not available in the following 
situations:

• When a setting other than "1 Up" is selected for "Multiple-Up" 
in the "Layout" tab 

• When a setting other than "Off" is selected for "Print Booklet" 
in the "Layout" tab 

• When "Double Print" is set to "On" under "Details" in the 
"Detailed Settings" tab 
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• When a size other than "A3," "B4," "A4," "B5," "8.5 x 11," "11 x 
17," "16K (267 x 194mm) / 8K (267 x 388mm)," and "16K (270 
x 195mm) / 8K (270 x 390mm)" is selected

• When a setting other than "None" or "On (Mixed Sizes)" is 
selected for "Hole Punching" in the "Paper / Output" tab 

• When a setting other than "None," "1 Staple (Mixed Sizes)," or 
"2 Staples (Mixed Sizes)" is selected for "Stapling" in the 
"Paper / Output" tab

– Stapling - Specify the position to staple mixed size 
originals. Select "1 Staple (Mixed Sizes)" or "2 Staples 
(Mixed Sizes)."

KEY POINT: If "Double Print" is set to "On" under "Details" in 
the "Detailed Settings" tab, the Stapling feature will not be 
available. 

– Hole Punching - Select "On (Mixed Sizes)" to enable hole 
punching feature for mixed size originals.

KEY POINT:When "Double Print" is set to "On" under "Details" 
in the "Detailed Settings" tab, Hole Punching feature will not 
be available.

– Hole Punching - Specify the number of holes to punch. 
Select from "Use Printer Settings," "2 Holes" or "4 Holes."

NOTE: If "3 Holes" is selected in "Hole Punching Settings" on the 
"Device Settings" tab, only "Use Printer Settings" will be available 
for selection.

Folding (Z Folding) If Tri-Fold Output Tray is installed, select the check box to perform 
Z folding for Mixed Size Documents.

• Image Rotation (180deg) - Turn the mixed size originals by 
180 degrees and print. 

• Select "Portrait," "Landscape," or "Portrait & Landscape (For 
envelopes)."

• If "2 Up" or more is selected in "Multiple-Up" on the "Layout" 
tab, individual pages will be rotated and printed. 
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• First Page - Specifies the "Paper Size" and "Image 
Orientation" of the first page of the mixed size document.

– Paper Size (First Page) - Specifies the paper size of the 
first page of the document.

The paper size combinations for mixed size originals are 
"A3 and A4," "B4 and B5," "8.5 x 11 and 11 x 17" and "16K 
and 8K."  "Paper Size" of the "Mixed Pages" will 
automatically be specified based on this setting.

– Image Orientation (First Page) - Specifies the image 
orientation of the first page of the document.

Select either "Portrait" or "Landscape."

• Mixed Pages - Specifies the "Paper Size" and "Image 
Orientation" of the mixed pages.

– Paper Size (Mixed Pages) - Displays the paper size of the 
mixed pages.

The paper size will automatically be specified based on the 
"Paper Size" settings of the first page.

– Image Orientation (Mixed Pages) - Specifies the image 
orientation of the mixed pages.

Select either "Portrait" or "Landscape."

Folding Select the folding method.

NOTE 1: "Z Fold”, "Z Tri-Fold," and "C Tri-Fold" will be available 
when the Tri-Fold Output Tray is installed and set up in the "Device 
Settings" tab.

NOTE 2: "Bi-Fold" is available when a Booklet Tray is installed and 
set up in the "Device Settings" tab.

Output Destination Select the paper output destination. Select "Auto Select" or 
"Finisher Tray (Large Output)" from the "Output Destination" 
menu.

Printer Status Open the Web browser and connect to CentreWare Internet 
Services for the printer to display the printer status.

To use CentreWare Internet Services, you must set the Internet 
Services on the printer to "Start."
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Layout tab

This section describes the Layout settings tab.

NOTE: You can restore defaults by clicking [Restore Defaults].
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Settings

Multi-Up Prints 2, 4, 6, 9 or 16 consecutive pages of the document on a 
single page of paper. This feature is known as "Multiple-Up."

Select the number of pages to be printed on a single page from "2 
Up," "4 Up," "6 Up," "9 Up," and "16 Up." The area of the paper to 
be printed is divided equally among the pages and the pages will 
be automatically rotated and reduced to fit into the page.

KEY POINT: If setting other than "Off" is selected in "Booklet 
Creation" on the "Layout" tab, only "1 Up" can be selected. You 
can check the result of the change in setting on the preview image 
at the top right of the screen.

Image Border Select this check box to add a border around every page of the 
original document when printed in Multiple-Up layout.

Print Booklet Specify the assembling and finishing methods for booklet 
creation. You can check the result of the change in setting on the 
preview image at the top right of the screen.

KEY POINT: "Booklet Creation" feature will only be available if 
"Automatically Select" or "Auto Paper Select (Type)" is selected in 
"Paper Source" on the "Paper / Output" tab.

Output Size for Booklet Specify the output size for booklet creation printing.

NOTE: When "Booklet Creation" is selected, only "AutoSelect 
Tray" and "Auto Paper Select (Type)" are available in "Paper 
Source" on the "Paper / Output" tab. Conversely, "Booklet 
Creation" feature is only available when "Automatically Select" or 
"Auto Paper Select (Type)" is selected in "Paper Source."

Booklet Subsets Specify the number of sheets in each subset when printing booklet 
in subsets. Select from "None," or "Every Sheet" to "Every "20 
Sheets."
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Gutter Select this box to add a Gutter Margin.

Margin Shift Clicking this button displays the "Margins" dialog box. Enter the 
position and the extent of the margin shift on the paper.

• Position - Specifies the margin shift (binding margin) 
position. The margin can be added to the left, right, top, or 
bottom of the paper. The margin positions change according to 
the paper orientation.

KEY POINT: If setting other than "Off" is selected in "Print 
Booklet" on the "Layout" tab, only "No Shift" will be available in 
"Position."

• Side 1 - Specifies the margin on side 1 of the paper when 
using the "Margin Shift" function. You can specify any value 
between 0 and 50 mm in units of 1mm using the keyboard or 
the up and down arrows.

• Side 2 - Specifies the margin on side 2 of the paper when 
using the "Margin Shift" function in 2-sided printing.

– The margin shift position for side 2 is automatically set so 
that the margin is added to the same edge as side 1.

– You can specify any value between 0 and 50 mm in units 
of 1mm using the keyboard or the up and down arrows.

Printer Status Open a Web browser and connect to CentreWare Internet 
Services for the printer to display the printer status.

To use CentreWare Internet Services, you must set the Internet 
Services on the printer to "Start.”

NOTE: This feature cannot be used when the printer is used as a 
local printer.
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This chapter contains information on:

• The software included for Macintosh OS 9.x or earlier, and 
Macintosh OS X

• Hardware and software requirements on page 5-2

• Adobe PS driver installation on page 5-3

• Print driver device options and print settings on page 5-11

• Screen font installation on page 5-23

About the software

This section describes the Macintosh software that is included on 
the PostScript Driver Library CD-ROM.

NOTE: When using AppleTalk protocol to print from Macintosh, 
set the EtherTalk port to Enable on the Control Panel.

Bundled software

Insert the CD-ROM and double-click the Adobe icon to display the 
window. The following items are contained in the folder:

AdobePS Printer Driver
(ver. 8.5.1, 8.7.0, and 8.8)

and PPD files

Adobe PostScript driver and PPD files (for Macintosh).

Xerox PPD Installer The PPD file installer for Mac OS X, 10.3.

Xerox PS Utility Enables you to define your printer settings.

Adobe Screen Fonts Contains 117 PostScript fonts and 19 TrueType fonts, which are 
standard for PostScript 3 printers. In addition, 37 PostScript fonts 
for the Central European (CE) character set are included.
Xerox 4110/4590 PostScr ipt User Guide 5-1



5.  Macintosh computers
ATM (Adobe Type Manager)
(ver. 4.5.2)

Helps you to install typefaces and activate and manage your fonts.

Adobe Acrobat Reader Allows you to view and print PDF files on all major computing 
platforms.

Readme.txt Contains cautionary notes about how to use the printer driver. 
Ensure you read this before use.

Hardware/software requirements

The minimum system requirements for the Macintosh printer 
driver and the utility are described below.

Computer system • Macintosh

• Power Macintosh

Basic software • For AdobePS 8.5.1 - Mac OS 7.1 through 8.1

• For AdobePS 8.7 - Mac OS 8.5 and 8.5.1

• For AdobePS 8.8 - Mac OS 8.6 through 9.2.2

• For PPD Installer - Mac OS X 10.2.x

• For PPD Installer - Mac OS X 10.3.3

• For Xerox PS Utility - Mac OS 7.1 or later

NOTE: When using Mac OS X, launch the Classic environment to 
run the applications.
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AdobePS Printer Driver 

KEY POINT: When installing the printer driver, ensure that you 
select the correct one (either 4110 or 4590).

This section describes how to install the Adobe printer driver and 
how to set the printer driver for this machine. There are two steps 
to install the printer driver. Firstly, use the installer enclosed on the 
CD-ROM to install the printer to the Macintosh. Then, configure 
the printer driver according to the printer used.

Installation procedure (Mac OS 9.x or earlier)

This section describes the procedures for installing the AdobePS 
printer driver.

NOTE: The procedure to install AdobePS 8.8 is shown here as an 
example.

1. Insert the PostScript Driver Library CD-ROM in the CD-ROM 
drive. 

The Adobe icon appears on the desktop.

2. Double-click [Adobe]. 

3. Double-click the [4100] folder and then the “AdobePS880” 
folder. 

4. Double-click [AdobePS Installer 8.8].

5. Click [Continue]. 
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6. Read through the license agreement carefully and if you have 
no objections to it, click [Accept]. 

Read the Read Me displayed, then click [Continue].

7. Confirm the Install Location and change it if necessary, then 
click [Install].

a. Installation begins.

b. When installation is complete, a dialog box appears.

8. Click [Continue] or [Quit]. 

• This completes the installation.

• Proceed to “Setting the Printer Driver (Mac OS 9.x or 
earlier)” on page 5-5 to continue.
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Setting the Printer Driver (Mac OS 9.x or earlier)

When you finish installing the AdobePS printer driver, set the 
PostScript Printer Description (PPD) file for this machine.

The printer driver controls the functions of this machine based on 
the information in the PPD file.

1. Check that the EtherTalk port on the Xerox 4110 Copier/Printer 
is set to Enable.

You can check the EtherTalk settings in the System Settings 
List. See the User Guide for details about how to print the 
System Settings List.

2. On the Macintosh computer, from the Apple menu select 
[Chooser], then click [AdobePS].

3. Select your printer from the Select a PostScript Printer list box, 
which appears to the right of the Chooser, then click [Setup].

The Macintosh computer automatically searches for the printer 
and sets the PPD file.

If the search for the PPD file is not automatically performed:

a) Click [Select PPD].

b) Select your printer model in the list, then click [Select]. 
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The PPD file for this machine is set.

4. Click [Configure] to set the options.

See “Printer options” on page 5-11 for details about the 
options.

NOTE 1: You can change the print settings after you install the 
printer driver.

NOTE 2: To use the options, it is necessary to set Configure. 
Always set this according to the configuration of your machine. 
Also, Installable Options will usually be set automatically 
according to the bi-directional communications of this 
machine. You do not have to change the settings.

5. Click [OK]. Click [OK] once more in the screen displayed.

6. Close the Chooser.
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Installation procedure (Mac OS X)

Use the following procedure to install the PostScript Printer 
Description (PPD) file for your Macintosh computer. The Mac OS 
(operating system) X version 10.2.x is used as the example 
throughout this procedure.

NOTE: The printer driver does not need to be installed on the Mac 
OS X. It uses the Adobe PostScript driver that is provided with the 
operating system.

1. Insert the PostScript Driver Library CD-ROM in the CD-ROM 
drive. The PS icon appears on the desktop.

2. Double-click [PS]. The PS window opens.

3. Open the [Mac] folder.

4. Open the [Mac OS X] folder. The Mac OS X window opens. 

5. Double-click [Xerox PPD Installer]. The installer starts and the 
Authenticate window opens.

6. Enter the Administrator user name and password, then click 
[OK].

The License screen opens.

7. Read through the license agreement carefully and, if you have 
no objections to it, click [Accept].
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8. Confirm the Install Location and change it if necessary, then 
click [Install].

9. Click [Quit].

This completes the installation.

Proceed to “Adding a Printer (Mac OS X)” on page 5-8 to 
continue.

Adding a Printer (Mac OS X)

After the PPD file has been installed, set the PPD file for the printer 
driver and then add the printer. The printer driver controls the 
printer functions based on the information in the PPD file. Use the 
following procedure to add a printer. This procedure uses 
Macintosh OS X v10.2.8 as its example.

NOTE: Menu items and procedures may vary slightly for Mac OS 
X v10.3.3 or other operating system versions.

1. Check that the port on the Xerox 4110 Copier / Printer is set to 
Enable.

• When using AppleTalk, set the EtherTalk port to Enable.

• When using IP Printing, set the LPD port to Enable.

You can check the EtherTalk and LPD settings in the System 
Settings List. See the User Guide for details about how to print 
the “System Settings List.”

2. Start [Print Center].

NOTE: You can find Print Center in the Utilities folder in the 
Applications folder. For Mac OS X 10.3.3, open the Printer 
Setup Utility in the Utilities folder in the Applications folder.
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The Printer List screen opens.

3. Click [Add].

4. Select the protocol used to connect the printer.

When using Apple Talk 1. Select [Apple Talk] from the menu, and specify the zone for the 
printer being used.

2. Select the printer you are using from the list.

3. Select [Auto Select] from Printer Model.

4. Click [Add].

After clicking [Add], a message may appear telling you that 
multiple printer files were found. Select the PPD file you will 
use and click [Add].

When using IP Printing 1. Select [IP Printing] from the menu, and enter the IP address 
for the printer being used in Printer’s Address.
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NOTE: For Mac OS X v10.3.3, select LPD/LPR for printer 
type.

2. Select [Xerox 4110 PS] from Printer Model, and select the 
printer to be used.

3. Click [Add].
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Printer options

1. Click [Printers] on the Print Center menu bar, and select [Show 
Info], or

For Mac OS X v10.3.3, click [Printers] on the Printer Setup 
Utility menu bar, then select [Show Info].

2. Select [Installable Options], and select the options that have 
been installed on the printer. See “Printer options” on page 5-
11 for details about the options.

This section describes the Configure dialog in the Chooser and the 
Printer Specific Options of the printer driver.

For Mac OS 9.x and earlier

This section describes installable options for Mac OS 9.x and 
earlier operating systems.

NOTE: Usually, installable options are automatically set according 
to the bi-directional communications of this machine. You do not 
have to change the settings.

1. Select the printer using the Chooser and click [Setup].

The Current Printer Description File (PPD) Selected dialog box 
appears.

2. Click [Configure].

The Installable Options list appears.

3. Set the option menu items in Installable Options, and click 
[OK]. 
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For Mac OS X

This section describes Installable Options for Mac OS X.

1. Click [Printers] on the Print Center menu bar, and select [Show 
Info].
For Mac OS X v10.3.3, click [Printers] on the Printer Setup 
Utility menu bar, then select [Show Info].

2. Select [Installable Options], and select the options that have 
been installed on the printer. 

Settings

Hole Puncher Setup Specify the number of holes to punch on the paper. Select from "2 
Holes/4 Holes" or "3 Holes."

High Capacity Feeder Select "Available" if the High Capacity Feeder has been installed.

Tri-Folding Output Tray Select "Available" if the Tri-Fold Output Tray is installed.

Booklet Output Tray Select "Available" if the Booklet Tray is installed.

Memory The built-in memory is 512MB.

Paper Size Settings Specify the paper size group for different locales to enable the 
selection of paper sizes common to that locale. The following 
groups of paper size categorized by locale are available: "AB 
Series," "AB Series (8K/16K)," "AB Series (8 x 13")," "AB Series (8 
x 13"/8 x 14")," and "Inch Series." As the paper size settings will 
be set automatically in accordance with the relevant locale, it is 
usually not necessary to change this setting.
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Switch Paper Size (8K/16K) Indicate your language preference to enable the set of 8K and 16K 
paper sizes that is best suited to your needs. If you select 
"Traditional Chinese," the dimensions of the 8K and 16K paper 
sizes are 267 x 388mm and 194 x 267mm respectively. If you 
select "Simplified Chinese," the dimensions will be 270 x 390mm 
and 195 x 270mm respectively.

NOTE: If "AB Series (8K/16K)" is not selected in "Paper Size 
Settings," both sets of 8K and 16K paper sizes will not be 
available despite the setting specified here.

Printer features

For Mac OS 9.x and earlier

This section describes how to set printer features for Macintosh 
OS 9.x and earlier.

1. On the File menu of the application, click [Print].

The Print dialog box appears.

2. Select [Printer Specific Options].

3. Specify the functions that you want to set.
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For Mac OS X

This section describes how to set printer features for Mac OS X.

1. On the File menu of the current application, click [Print].

The Print dialog box appears.

2. Select [Printer Features].

3. Specify the functions that you want to set.
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Settings

This section describes the settings in the Printer Specific Options 
list. The settings that can be selected vary depending on which 
options have been installed. Make these settings after specifying 
the installed options in Configure. See “Printer options” on page 5-
11.

Offset Stacking The position of individual jobs or sets of copies are shifted to either 
side of the output tray to enable easy separation.

Collated Selects whether to collate a multiple-page file per set when they 
are printed.

Feed Separators from Specifies the paper tray that transparency dividers are to be fed 
from. When [Auto] is selected, the tray set on the machine is used 
as the feed destination.

Print on Separators Specifies whether or not to print on the transparency dividers as 
well as the transparency.

Front Cover Specify whether to add front cover to the printouts. Select the 
paper tray for feeding the front cover sheets.

Back Cover Specify whether to add back cover to the printouts. Select the 
paper tray for feeding the back cover sheets.

Tray 8 - Specify Tab Stock Specifies whether tab stock is being loaded in tray 8. Select either 
"Plain" or "Tab Stock."

Stapling Specifies whether or not to staple printed documents and the 

position of the staple. You can staple 2 to 50 sheets of 80 g/m2 or 
lighter paper.

Hole Punching Select the punching position. The holes are made based on the 
output orientation of the paper. As a result, the holes may not be 
punched correctly depending on the position of the image.

Hole Punching Specify the number of holes to punch. Select from "Use Printer 
Settings," "2 Holes," or "4 Holes." If "3 Holes" is selected for "Hole 
Puncher Setup," only "Use Printer Settings" will be available for 
selection.
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Folding Select the folding method.

Double Print Enable this feature to repeatedly print one page twice on a paper 
with a bigger size than the original. You can use Double Print 
feature if you have set the zoom ratio to 100% with the following 
paper size and output size settings.

• Paper Size • Output Size

• A4 • A3

• A5 • A4

• B5 • B4

• Folio (8.5 x 11") • Ledger (11 x 17")

Booklet Creation Specify the assembling and finishing methods for booklet 
creation. You can check the result of the change in setting on the 
preview image at the top right of the screen.

Output Size for Booklet
Creation

Specify the output size for booklet creation printing.

Booklet Subsets Specify the number of sheets in each subset when printing booklet 
in subsets. Select from "None," or "Every Sheet" to "Every 20 
Sheets."

Skip Blank Pages Specify whether to skip blank pages when printing documents that 
consist of blank pages.

Bypass Feed Orientation Specifies the paper orientation when printing from the bypass 
tray. When feeding the short edge of the paper first, select 
[Landscape]. When feeding the long edge of the paper, select 
[Portrait].

Paper Type/Media Select the paper type to be used for printing.

Output Destination Select the paper output destination.

Print Mode Specifies whether to give priority to the print speed or the image 
quality.

Halftone Select the halftone settings for printing.

• Select [Fine Dots] for the small size halftone dot commonly 
used in PostScript.

• Select [Thick Dots] for coarser dots than the Fine Dots setting.

• Select [Type 3] for the same halftone setting that is used in 
PCL.
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Image Enhancement Specifies whether or not to use the Image Enhancement function. 
Selecting [On] smooths out boundaries when printing. This 
reduces jagged edges by artificially increasing the resolution of 
the image. When printing a bitmapped image composed of 
coarse halftone dots, smooth color or grayscale gradation is 
impossible in certain situations. In this case, select [Off].

Draft Mode Specifies whether or not to reduce the amount of toner used when 
printing drafts. When [On] is selected, the overall printed page 
becomes lighter. This is best for printing documents when high 
print quality is not necessary.

Custom Paper Auto
Orientation

Specifies whether or not to correct the orientation of the custom 
paper.

Substitute Tray Specifies what action to take when the paper for the print size is 
not loaded in the machine.

• Use Printer Settings - Use the printer settings. The settings 
can be confirmed on the control panel.

• Display Message - Display paper supply messages on the 
control panel. Printing is impossible until paper is supplied.

• Use Nearest Size (Adjust to Fit) - Selects the nearest paper 
size and automatically adjusts the image size as necessary.

• Use Nearest Size (No Zoom) - Selects the nearest paper size 
and prints the same size as the image.

• Use Larger Size (Adjust to Fit) - Selects paper larger than 
the original and automatically adjusts the image size as 
necessary.

• Use Larger Size (No Zoom) - Selects paper larger than the 
original and prints the same size as the image.

• Feed from Bypass Tray - Feed from bypass tray.

Print Mixed Size Originals Controls the orientation of the second-side image when printing 
double-sided.
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Job Type (Mac OS X only)

This section describes the Job Type features available when 
printing.

1. On the File menu of the current application, click [Print].

The Print dialog box appears.

2. Select [Job Type].

3. Specify the functions that you want to set.
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Settings

Job Type You can specify the print function for Secure Print, Sample Print, 
and Delayed Print.

• Secure Print temporarily stores print jobs in the printer, and 
then prints them when print instructions are received from the 
control panel.

• Sample Print outputs only one copy when multiple copies are 
specified. If there is no problem, the remaining sets can be 
printed.

• Delayed Print temporarily stores print jobs in the printer, and 
then prints them at the scheduled time.

To use the Secure Print or Sample Print feature, input the User ID 
and password for Print Type. The password entered appears as 
bullets ( ).

• Normal Print - Select when you do not want to output 
secure prints, sample prints, or delayed prints.

• Secure Print - Select when you want to output secure 
prints.

• Sample Print - Select when you want to output sample 
prints.

• Delayed Print - Select when you want to output delayed 
prints. 

See the Online Help for details on the operation of the printer.

User ID Enter the User ID for Secure Print or Sample Print.

Password Enter the password for Secure Print. Each digit entered appears 
as a bullet ( ).

Retrieve Document Name Select the method for specifying the document name. If you have 
selected Auto Retrieve, the valid document name can be up to 24 
alphanumeric characters.

Document Name When "Enter Document Name" is selected in the Retrieve 
Document Name list, a document name up to 24 alphanumeric 
characters can be specified.

Start Print Time Specifies the time when a Delayed Print job will be printed. Place 
the cursor in the hour or minute box and press the up or down 
triangle to specify the start time. You can also set the time by 
entering the time directly into the boxes. The default setting is 
00:00.
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Job Accounting (Mac OS X only)

This section describes the Job Accounting features available 
when printing.

1. On the File menu of the current application, click [Print].

The Print dialog box appears.

2. Select [Job Accounting].
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3. Specify the functions that you want to set.
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Settings

Account Mode Specifies if all users or only System Administrators can change 
authentication related settings.

Detailed User Settings Opens the Detailed User Settings dialog box used to set the 
authentication information.

Use Default User Details - The values set in this feature are used 
as the authentication parameters.

• Specify Job Owner Name - Select how to specify User ID.

• Job Owner Name - Enter a User ID.

• Password - Enter a Password that matches the User ID. The 
password entered appears as bullets ( ).

• Account ID - Enter an Account ID.

• Billing ID - Enter a User ID for Charge Print.

• Password - Enter a Password that matches the Billing ID. The 
password entered appears as bullets ( ).

• Prompt User for Settings - Select this feature to display the 
[Enter User Details] dialog box each time you start printing. 
The user is then required to enter authentication information 
such as their User ID.

• Display Previous User Details - Select the check box to 
store the user details entered in the [Enter User Details] dialog 
box, and display the details in the box as a default next time.

• Hide User ID - Select the check box to specify whether a user 
ID is to be displayed or hidden when it is entered.

• Hide Account ID - Select the check box to specify whether an 
account ID is to be displayed or hidden when it is entered.
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Installing screen fonts

This section explains how to install the fonts in the Screen Font 
folder.

KEY POINT: It is recommended that all other applications are 
closed before installing the fonts. If applications are not closed, a 
warning message appears between Step 5 and Step 6.

1. Start Macintosh and insert the PostScript Driver Library CD-
ROM into the CD-ROM drive.

2. Double-click the [PS] icon followed by the Screen Font folder 
and then the [PS3 Fonts Installer]. The following window 
appears: 

3. Click [Continue].

The license agreement dialog appears.

4. Read through the agreement carefully and if you have no 
objections to it, click [Accept].

The PS3FontsInstaller dialog box appears.
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5. You may select [Easy Install] or [Custom Install].

• Easy Install - installs all the fonts provided in the Screen 
Font folder. 

• Custom Install - installs the selected fonts only. Click on 
the triangle arrow beside the four categories of fonts to 
display the fonts in each category and then check the fonts 
to be installed. For example, the diagram below shows that 
Arial CE of the CE TrueType fonts is selected. 

A warning message will appear if you did not quit all other 
applications before performing the font installation.

6. Click [Install].

• The installation of the fonts begins.

• After the installation, you have to restart your Macintosh 
before the fonts can be used.

• Store your CD-ROM in a safe place.
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6. Barcode Settings

This chapter contains information on:

• Barcode settings

• Character set tables on page 6-3

• Barcode sizes on page 6-13

About barcode settings

This section lists the types of compatible barcodes, designated 
character sets for barcode characters, and sizes of printed 
barcodes.

NOTE: This guide assumes that the operator has a basic 
knowledge of barcodes.
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Font types and character sets

The table below lists compatible barcode types.

For the character set used to specify each barcode character, see 
“Character set tables” on page 6-3.

See “Barcode sizes” on page 6-13 for details about the size of 
printed barcode.

NOTE: The printed barcode’s readability depends largely on 
factors such as the quality of paper used and performance of the 
barcode reader. Before using this product, we recommend you 
thoroughly test it under the conditions in which it will be used.

Sample program and output results

A program that prints a sample of each type of barcode and a PDF 
showing the output results is provided. Use these samples as a 
reference when printing barcodes.

• Location of sample program and output results in PDF

Located in the [manual] > [sample] folder on the PostScript 
Driver Library CD-ROM

• Sample program name

Sample.ps

• Output results PDF name

Sample.pdf

Barcode type PostScript font name Refer to the following table

JAN HitachiITHINJANH8-RG JAN Character Set Table (page 6-3)

Code 39 HitachiIT-C39H8 Code 39 Character Set Table (page 6-4)

NW7 HitachiITHINNW7H8-RG NW7 Character Set Table (page 6-5)

Code 128 HitachiITHINC128H8-RG Code 128 Character Set Table (page 6-6)

ITF (without bearer 
bar)

HitachiITHINITFH8-RG
ITF (Interleaved 2 of 5)
Character Set Table   (page 6-10)

ITF (with bearer bar) HitachiITHINITFB-RG

Customer Barcode HitachiITHINPOSTBC-RG Customer Barcode Character Set Table (page 6-12)

Font type PostScript font name

OCR B LetterPress M OCRBLetM
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Character set tables

This section describes the character sets used when specifying 
barcode character for each barcode type.

 JAN character set table

The table below lists the character sets used when printing JAN 
barcode characters.

Character

Character set

Left side odd parity Left side even parity Right side even parity

HEX notation ASCII 
notation

HEX 
notation

ASCII 
notation

HEX 
notation

ASCII 
notation

0 30 0 41 A 4B K

1 31 1 42 B 4C L

2 32 2 43 C 4D M

3 33 3 44 D 4E N

4 34 4 45 E 4F O

5 35 5 46 F 50 P

6 36 6 47 G 51 Q

7 37 7 48 H 52 R

8 38 8 49 I 53 S

9 39 9 4A J 54 T

Left side 
guard bar

22 "

Right side 
guard bar

23 #

Center bar 21 !
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Code 39 character set table

The table below lists the character sets used when printing Code 
39 barcode characters.

Character

Character set

Character

Character set

Character

Character set

HEX 
notation

ASCII 
notation

HEX 
notation

ASCII 
notation

HEX 
notation

ASCII 
notation

$ 24 $ 8 38 8 M 4D M

% 25 % 9 39 9 N 4E N

* 2A * (SP) 20 SP O 4F O

+ 2B + A 41 A P 50 P

- 2D - B 42 B Q 51 Q

. 2E . C 43 C R 52 R

/ 2F / D 44 D S 53 S

0 30 0 E 45 E T 54 T

1 31 1 F 46 F U 55 U

2 32 2 G 47 G V 56 V

3 33 3 H 48 H W 57 W

4 34 4 I 49 I X 58 X

5 35 5 J 4A J Y 59 Y

6 36 6 K 4B K Z 5A Z

7 37 7 L 4C L (SP) 40 @
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NW7 character set table

The table below lists the character sets used when printing NW7 
barcode characters.

Character

Character set

Character

Character set

Character

Character set

HEX 
notation

ASCII 
notation

HEX 
notation

ASCII 
notation

HEX 
notation

ASCII 
notation

$ 24 $ 0 30 0 A 41 A

+ 2B + 1 31 1 B 42 B

- 2D - 2 32 2 C 43 C

. 2E . 3 33 3 D 44 D

/ 2F / 4 34 4 A 61 a

5 35 5 B 62 b

6 36 6 C 63 c

7 37 7 D 64 d

8 38 8

9 39 9

: 3A :
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Code 128 character set table

The table below lists the character sets used when printing Code 
128 barcode characters.

Value

Character Character set

CODE A CODE B CODE C HEX 
notation

ASCII 
notation

0 SP SP 00 20 SP

1 ! ! 01 21 !

2 " " 02 22 "

3 # # 03 23 #

4 $ $ 04 24 $

5 % % 05 25 %

6 & & 06 26 &

7 ' ' 07 27 '

8 ( ( 08 28 (

9 ) ) 09 29 )

10 * * 10 2A *

11 + + 11 2B +

12 , , 12 2C ,

13 - - 13 2D -

14 . . 14 2E .

15 / / 15 2F /

16 0 0 16 30 0

17 1 1 17 31 1

18 2 2 18 32 2

19 3 3 19 33 3

20 4 4 20 34 4

21 5 5 21 35 5

22 6 6 22 36 6

23 7 7 23 37 7

24 8 8 24 38 8

25 9 9 25 39 9

26 : : 26 3A :

27 ; ; 27 3B ;

28 < < 28 3C <
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29 = = 29 3D =

30 > > 30 3E >

31 ? ? 31 3F ?

32 @ @ 32 40 @

33 A A 33 41 A

34 B B 34 42 B

35 C C 35 43 C

36 D D 36 44 D

37 E E 37 45 E

38 F F 38 46 F

39 G G 39 47 G

40 H H 40 48 H

41 I I 41 49 I

42 J J 42 4A J

43 K K 43 4B K

44 L L 44 4C L

45 M M 45 4D M

46 N N 46 4E N

47 O O 47 4F O

48 P P 48 50 P

49 Q Q 49 51 Q

50 R R 50 52 R

51 S S 51 53 S

52 T T 52 54 T

53 U U 53 55 U

54 V V 54 56 V

55 W W 55 57 W

56 X X 56 58 X

57 Y Y 57 59 Y

58 Z Z 58 5A Z

59 [ [ 59 5B [

60 \ \ 60 5C \

61 ] ] 61 5D ]

Value

Character Character set

CODE A CODE B CODE C HEX 
notation

ASCII 
notation
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62 ^ ^ 62 5E ^

63 _ _ 63 5F _

64 NUL ` 64 60 `

65 SOH a 65 61 a

66 STX b 66 62 b

67 ETX c 67 63 c

68 EOT d 68 64 d

69 ENQ e 69 65 e

70 ACK f 70 66 f

71 BEL g 71 67 g

72 BS h 72 68 h

73 HT I 73 69 I

74 LF j 74 6A j

75 VT k 75 6B k

76 FF l 76 6C l

77 CR m 77 6D m

78 SO n 78 6E n

79 SI o 79 6F o

80 DLE p 80 70 p

81 DC1 q 81 71 q

82 DC2 r 82 72 r

83 DC3 s 83 73 s

84 DC4 t 84 74 t

85 NAK u 85 75 u

86 SYN v 86 76 v

87 ETB w 87 77 w

88 CAN x 88 78 x

89 EM y 89 79 y

90 SUB z 90 7A z

91 ESC { 91 7B {

92 FS | 92 7C |

93 GS } 93 7D }

94 RS ~ 94 7E ~

Value

Character Character set

CODE A CODE B CODE C HEX 
notation

ASCII 
notation
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95 US DEL 95 7F DEL

96 FNC 3 FNC 3 96 A1

97 FNC 2 FNC 2 97 A2

98 SHIFT SHIFT 98 A3

99 CODE C CODE C 99 A4

100 CODE B FNC 4 CODE B A5

101 FNC 4 CODE A CODE A A6

102 FNC 1 FNC 1 FNC 1 A7

103 START(CODE A) A8

104 START(CODE B) A9

105 START(CODE C) AA

106 STOP AB

Value

Character Character set

CODE A CODE B CODE C HEX 
notation

ASCII 
notation
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6.  Barcode Sett ings
ITF (Interleaved 2 of 5) character set table

The table below lists the character sets used when printing ITF 
barcode characters.

Character

Character set

Character

Character set

Character

Character set

HEX 
notation

ASCII 
notation

HEX 
notation

ASCII 
notation

HEX 
notation

ASCII 
notation

00 21 ! 30 3F ? 60 5D ]

01 22 " 31 40 @ 61 5E ^

02 23 # 32 41 A 62 5F _

03 24 $ 33 42 B 63 60 `

04 25 % 34 43 C 64 61 a

05 26 & 35 44 D 65 62 b

06 27 ' 36 45 E 66 63 c

07 28 ( 37 46 F 67 64 d

08 29 ) 38 47 G 68 65 E

09 2A * 39 48 H 69 66 F

10 2B + 40 49 I 70 67 G

11 2C , 41 4A J 71 68 H

12 2D - 42 4B K 72 69 I

13 2E . 43 4C L 73 6A J

14 2F / 44 4D M 74 6B K

15 30 0 45 4E N 75 6C L

16 31 1 46 4F O 76 6D M

17 32 2 47 50 P 77 6E N

18 33 3 48 51 Q 78 6F O

19 34 4 49 52 R 79 70 P

20 35 5 50 53 S 80 71 Q

21 36 6 51 54 T 81 72 R

22 37 7 52 55 U 82 73 S

23 38 8 53 56 V 83 74 T

24 39 9 54 57 W 84 75 U

25 3A : 55 58 X 85 76 V

26 3B ; 56 59 Y 86 77 W

27 3C < 57 5A Z 87 78 X

28 3D = 58 5B [ 88 79 Y
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6.  Barcode Sett ings
With ITF, one character set specifies the pair of a character 
denoted by a bar and a character denoted by a space.

However, the START and the STOP character are specified by 
one character set.

Example:

To print the pair of characters of the bar representing “3” and the 
space representing “7”, specify “46” (HEX notation).

To print the pair of characters of the bar representing “7” and the 
space representing “3”, specify “6A” (HEX notation).

29 3E > 59 5C \ 89 7A Z

90 7B { 94 A1 DEL 98 A5

91 7C | 95 A2 99 A6

92 7D } 96 A3 START A7

93 7E ~ 97 A4 STOP A8

Character

Character set

Character

Character set

Character

Character set

HEX 
notation

ASCII 
notation

HEX 
notation

ASCII 
notation

HEX 
notation

ASCII 
notation
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6.  Barcode Sett ings
Customer barcode character set table

The table below lists the character sets used when printing 
customer barcode characters.

Character

Character set

Character

Character set

HEX 
notation

ASCII 
notation

HEX 
notation

ASCII 
notation

START 3C < CC1 61 a

STOP 3E > CC2 62 b

- 2D - CC3 63 c

0 30 0 CC4 64 d

1 31 1 CC5 65 e

2 32 2 CC6 65 f

3 33 3 CC7 67 g

4 34 4 CC8 68 h

5 35 5

6 36 6

7 37 7

8 38 8

9 39 9
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6.  Barcode Sett ings
Barcode sizes

The table below lists formulae for calculating the approximate 
dimensions of printed barcodes.

The dimensions of the barcode printed may vary, even when using 
the same program, depending on conditions such as the 
characteristics and resolution of the printer used, paper quality, 
and so forth. The dimensions derived from the formulae in this 
table are not guaranteed to be the actual dimensions of the printed 
barcodes. Use this table as a reference when estimating the size 
of printed barcodes.

P: Font size (point)

C: Number of characters

C1: Number of characters (0,1,2,3,4,5,6,7,8,9,-,$)

C2: Number of characters (:,/,.,+,A,B,C,D)

Barcodes
type

Formulae

Width Height

JAN (standard) P × 0.502 P × 0.352

Side margins not included. Indicates the height of the guard bar.

JAN (short version) P × 0.354 P × 0.352

Side margins not included. Indicates the height of the guard bar.

Code 39 P × (C + 2) × 0.106 P × 0.352

Inter character gap of the left and right 
sides not included.
“C” includes the checkdigit.

NW7 P × (C1 × 0.132 + C2 × 0.148 − 0.026) P × 0.352

Inter character gap of the left and right 
sides not included.
“C1” and “C2” include the checkdigit.

Code 128 P × (C × 0.081 + 0.096) P × 0.352

Formula for CODE C.

ITF
(without bearer bar)

P × ((C/2 × 0.175) +0.093) P × 0.352

Quiet zone not included.
“C” includes the checkdigit.

ITF
(with bearer bar)

P × ((C/2 × 0.137) + 0.323) P × 0.352

Bearer bar and quiet zone included.
“C” includes the checkdigit.

Bearer bar included.

Customer Barcode P × 7.297 P × 0.342

Spaces before the black bar of START 
code and after the black bar of the STOP 
code are not included.

Indicates the height of the long bar.
Xerox 4110/4590 PostScr ipt User Guide 6-13



6.  Barcode Sett ings
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A. Appendix

Cautions and limitations

About the driver

Cautions and limitations relating to each type of driver are listed in 
the Readme.txt file in the PostScript Driver Library CD-ROM. 
Ensure you read it before installing the driver.

Troubleshooting

See the User Guide for error codes and error messages displayed 
on the control panel and how to deal with paper jams.

Print operation

The printer driver allows you to make selections to print on custom 
paper and postcards using duplex and/or the stapling feature to 
the Finisher Tray. However, if you are printing on custom paper or 
postcards, these features will not function even though you may 
still be able to select them.

You can feed custom paper from the bypass tray only. However, 
when you select custom paper, the Paper Source selection does 
not change to Manual Feed automatically. Please select Manual 
Feed yourself.
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